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General 
 
All screenshots herein are referencing ActiLife versions 5.0 and higher. 

© 2011 ActiGraph.  All Rights Reserved. 

This document is copyrighted by ActiGraph, with all rights reserved. 

Trademarks  
Windows and Excel are registered trademarks of the Microsoft Corporation.  

Adobe and Reader are registered trademarks of Adobe Systems Incorporated.  

Pentium is a registered trademark of the Intel Corporation or its subsidiaries.  
 

System Requirements  

 512MB RAM minimum 

 1000MHz processor minimum 

 20MB of free disk space minimum  

 USB 2.0 Compliant Port 

 Microsoft Windows (Works with XP, Vista, & W7 – 32 or 64 bit) 
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Important Information and Symbols 

 

Type B Applied Part.  This symbol means that we are compliant with IEC (International 
Electrotechnical Commission) standards for "Type B Applied Part" - meaning that we comply with 
requirements for protection against electrical shock. More details available 
at: http://content.yudu.com/Library/A1l2bv/APracticalGuideto606/resources/8.htm 

 

CAUTION:  Do not simultaneously charge and wear the device.  The end user should not be in the 
patient vicinity when being charged1

 

 

Part 15.107 (US) – Conducted Limits of Unintentional Radiators  
Part 15.109 (US) – Radiated Emission Limits of Unintentional Radiators  
The FCC symbol is placed on our device to reflect our compliance with radio emissions restrictions 
in congruence with FCC reguilations 15 Part 107 and 15 Part 109 

 

EN60101-1  
ICES0003 (Canada) – Interference Causing Equipment Standards (Digital Apparatus).  The CE 
symbol stands for Conformité Européenne which means "European Conformity" in 
French.ActiGraph devices have met the European Union's requirements to sell medical devices in 
Europe. More details about this compliance is available at http://en.wikipedia.org/wiki/CE_mark.   

 

Contact ActiGraph Customer Service regarding disposal of products 

 

All ActiGraph products are manufactured Lead Free and are RoHS Compliant 

 

International Protection Rating:  The GT3X-plus is water resistant in accordance with IEC 60529 
IPX7, or immersion in one (1) meter of water for up to 30 minutes.  More details can be found at 
http://en.wikipedia.org/wiki/IP_Code 
 

 This devices produces no known physiological effects 

 

 

  

                                                            
1 A patient vicinity is areas in which PATIENTS are normally cared for and the space with surfaces likely to be contacted by the PATIENT or an 
attendant who can touch the PATIENT. This encloses a space within the room 1,83 m (6 feet) beyond the perimeter of the bed (examination table, 
dental chair, treatment booth, and the like) in its intended location, and extending vertically 2,29 m (7-1/2 feet) above the floor. 

http://content.yudu.com/Library/A1l2bv/APracticalGuideto606/resources/8.htm�
http://ecfr.gpoaccess.gov/cgi/t/text/text-idx?c=ecfr&sid=2b694535cea48b3d9e7ea10be8fa1d9a&rgn=div8&view=text&node=47:1.0.1.1.14.2.242.5&idno=47�
http://ecfr.gpoaccess.gov/cgi/t/text/text-idx?c=ecfr&sid=2b694535cea48b3d9e7ea10be8fa1d9a&rgn=div8&view=text&node=47:1.0.1.1.14.2.242.6&idno=47�
http://en.wikipedia.org/wiki/CE_mark�
http://en.wikipedia.org/wiki/IP_Code�
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Introduction 
ActiLife 5 analysis software package supports the GT1M, GT3X, GT3X-plus, ActiSleep Monitor (ASM), and ActiTrainer 
activity monitors.  The program provides a means to configure these activity monitors (initialize) as well as download 
and analyze the data collected by the devices.   

Wearing the Device 
All ActiGraph activity monitors are designed to monitor human activity and record energy expenditure (calories spent 
during normal activity, METs, everyday activity, and exercise).  Additionally, these devices can also function as a very 
accurate sleep assessment tool2

 

.  While collecting day-to-day energy expenditure data, the device should be affixed 
securely to the body’s center-of-mass to ensure the most accurate caloric measurements.  Wrist worn (nonvalidated) EE 
for kids is now available for 3-axis actigraphs. When being used for sleep assessment, the ActiGraph device may be worn 
anywhere on the body: wrist, waist (hip), arm, or ankle.   

Note: It is not safe to wear the ActiGraph while it is charging.  

 

To use the elastic waist belt, lace the belt through the side loops of the actigraph device and secure the belt around the 
waist.  The unit can be worn either above or beneath clothing, and it is not necessary for the device to make contact 
with the skin.  However, the device must be held snugly against the body to prevent erroneous readings.  To use the 
belt clip, attach the clip to the back of the actigraph using the double-sided adhesive strip and attach the unit securely to 
a belt on the subject’s hip. 

Note: The belt clip adheres permanently to the ActiGraph.  Once the belt clip is attached to the 
back of the Actigraph, you will not be able to wear it on the elastic belt comfortably.  It is 
important to determine which method is best for you before the belt clip is attached to the back 
of the Actigraph.   

It is recommended that children under 12 years of age wear the Actigraphs on the elastic belt (versus the adhesive belt 
clip) as it is the most secure way to wear the device. Belt loop pouches, wrist and ankle straps are also available. 

The same recommendations apply to the ActiTrainer: the device should be worn on the waist using the supplied 
neoprene pouch and belt for normal, daily activity but can be worn on the wrist, ankle, or upper arm for sleep 

                                                            
2 Sleep analysis can also be performed by purchasing ActiGraph’s ActiSleep analysis program, which is part of the Virtual Trainer, web-based, 
analysis software.  Formulas for this tool were developed by Dr. Avi Sadeh. Department of Psychology, Tel Aviv University. 
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assessment.  The ActiTrainer may be worn on the arm using a neoprene armband; however, energy expenditure 
calculations will not be as accurate at this location.  

The ActiTrainers manufactured after July 1, 2009 have a 3 axis accelerometer as do the GT3X series and ASM Actigraphs.  
The ActiTrainer memory has also been expanded to 4 MB, four times storage capacity of the earlier model (see memory 
matrix on page 10).   

The GT3Xs, ActiTrainers with 3 axis accelerometers and the ASM have an Inclinometer feature.  The Inclinometer will 
only function properly when the device is worn at the hip area of the waist.   
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Product Specifications and Functionality 

Epochs and Data Storage 
Data is stored on ActiGraph products in one of two ways: either post-filtered and accumulated or raw. 

Post Filtered/Accumulated 
Post-filtered and accumulated data is typically stored in time buckets referred to as “Epochs.”  On ActiGraph devices, 
“Epochs” are whole-second numbers (e.g., 1s, 5s, 60s, 120s, etc.).  For each epoch interval, data samples taken from the 
accelerometer inside the device at a rate of 30Hz are first filtered then accumulated before being stored in memory.  For 
example, a device set to collect 60 second epoch data will store 30 × 60 = 1800 accumulated samples for each enabled 
axis on the device every 60 seconds. 

GT3X+ devices do not store post-filtered/accumulated data – only raw data. 

Raw 
Devices can be set to store data in raw mode by selecting a sample frequency (12Hz or 30Hz) rather than a whole-
second number in the “Epoch” dropdown during the initialization process.  When raw mode is set, devices store raw 
(non-filtered/accumulated) accelerometer data (in units of gravity – G’s) directly into memory at the selected rate (12Hz 
or 30Hz).  When raw mode is enabled, non-accelerometer channels (steps, inclinometer, and lux) are disabled. 

Data stored at 12Hz is stored at a resolution of 1/10 (0.1) G (unit of gravity).  Data recorded at 30Hz is recorded at a 
resolution of 1 milli-G (Plus or minus 3G limit). 

The GT3X+ product stores data in raw mode at all times.  Data collection frequency is variable (30Hz up to 100Hz in 10Hz 
increments) and can be set during initialization.  Similar to other devices, the GT3X+ stores raw accelerometer samples 
in units of G’s at the indicated frequency.  However, unlike other devices it also stores lux (ambient light) samples once 
per second at all times.  See Appendix A for information about the *.gt3x file that is downloaded from the GT3X+ device.   

The GT3X+ has a dynamic range of +/- 6 Gs. 

Available Channels (Modes) 
Table 8 in Memory Size and Data Storage outlines all of the data channels that can be logged on ActiGraph products and 
includes the memory size for each product.  For all devices except for the GT3X+, these modes can be selected during 
initialization.  Note that the GT3X+ collects all data channels regardless of initialization settings. 

The following channel descriptions apply to several products as described in Table 8. 

2-Axis/3-Axis Data 
Two-Axis data collection refers to acceleration data parallel to Axis 1 and Axis 2 of a device.  Individual axis data 
collection is not permitted (e.g., “Only record Axis 2 data”).  Axis selection options for the ASM, ActiTrainer, GT1M, and 
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GT3X include a combination of Axis 1 and Axis 2 or Axis 1, Axis2, and Axis 3.  GT3X+ devices collect data from all three 
axes regardless of configuration.  Error! Reference source not found. illustrates each device’s orientation while Table 8 
in Memory Size and Data Storage defines which devices support multi axis data collection. 

For standard epoch values (non-raw data epoch collection intervals), accelerometer data is sampled at a rate of 30Hz, 
passed through ActiGraph’s proprietary filter algorithm, then accumulated until the end of an epoch window is reached.  
For instance, devices set to collect data at 1-second epochs will store a sum of 30 filtered samples per epoch. 

GT3X+ Device Axis Orientation 
Figure 1 illustrates the axis orientation of the GT3X+ device. 

 

 

Figure 1 – GT3X+ Axis Orientation 

Other Device Orientation 
The orientation of the ActiSleep Monitor, ActiTrainer, and GT1M/GT3X devices are shown in Figure 2. 

 
Figure 2 – ASM, ActiTrainer, GT1M, and GT3X axis orientation 
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Steps 
Step counts are accumulated on a per-epoch basis and are based on accelerometer data collected on Axis 1 (the vertical 
axis).  An algorithm present in the device firmware filters out the accelerometer’s baseline noise level to help accurately 
accumulate the steps-per-epoch. 

Inclinometer 
The inclinometer feature can help users identify the orientation of the device and, more importantly, when the device 
itself was taken off.  Each epoch is flagged with a number (1 through 4) to indicate the orientation of the device during 
that epoch.  For GT3X+ devices, this is done when converting the *.gt3x file to *.agd format.  As noted, the inclinometer 
feature is only valid when the device is worn vertically on the point of the hip.  More details are available in the 
Inclinometer Whitepaper. 

Important   The inclinometer feature is only valid if the device is worn on the hip with Axis 1 
upward facing. 

Inclinometer Code 
(Stored with each Epoch) 

Interpretation 

0 Device Off (Not Being Worn) 
1 Subject Standing 
2 Subject Lying Horizontal 
3 Subject Sitting 
Table 1 - Inclinometer Definitions 

Off Indication on GT3X+ versus other devices 
The Inclinometer feature offers researchers the ability to detect periods of time during which the device was not worn.  
For non-GT3X+ devices, the inclinometer algorithm makes this prediction by examining the angle at which the device is 
placed.  In GT3X+ devices, off detection performed by analyzing both the angle at which the unit is placed as well as the 
length of time the device remains still.  Absolute stillness for three (3) minutes indicates that the unit is likely in an “off” 
condition regardless of orientation.  As such, epochs that follow three motionless minutes of activity are flagged as “off,” 
i.e., the inclinometer code is equal to zero.  These values are not retroactive.  That is, the first three minutes of zero 
activity are not flagged as “off.”  In addition, 30 minutes in the “off” orientation will cause the inclinometer value to 
indicate off after that time period has elapsed regardless of motion.   

At this time, the inclinometer feature is being validated by the research community. 

Lux (Ambient Light) 
Some devices contain an ambient light sensor capable of measuring the intensity of light.  Lux data is stored once per 
epoch.  For GT3X+ devices, Lux data is stored once per second.  When converting a GT3X+ raw file into an accumulated 
*.agd format with epoch lengths greater than one second (see Uncompressing *.gt3x Files), the lux values for that epoch 
are averaged.  An estimate of lux values is shown in Table 2. 

https://docs0.google.com/document/d/1EBAEcAL34k0ONZOgfXZPsMJJC-Uy9d49FFyPnmPH3Qc/edit?hl=en&authkey=CM--zvgE�
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Lux Level Interpretation Comparison 
1 Twilight 
5 Minimal street light 

10 Sunset 
50 Family living room 
80 Hallway 

100 Very dark overcast day 
320-500 Office lighting 

400 Sunrise/sunset 
1,000 Overcast day 

10,000-25,000 Full daylight 
32,000-130,000 Direct sunlight 

Table 2 – Lux Level Interpretation Estimates 

Low Frequency Extension 
The Low Frequency Extension (LFE) option, though not a mode or channel, is another data collection option during 
device initialization and, for the GT3X+, during post-processing.  The Normal proprietary filter algorithm used in 
ActiGraph products is used to eliminate any acceleration noise outside of the normal human activity frequency 
bandwidth.  This filter is customized to work with ActiGraph’s Energy Expenditure Algorithms.  The LFE option, when 
enabled, extends the lower end (baseband) of the filter cutoff, effectively expanding the bandwidth of the accumulated 
data.  This option is useful when measuring actigraphy data for subjects who move slowly or take very light steps (for 
example, the elderly).  For more details, contact ActiGraph at support@theactigraph.com.   

GT3X+ Caveats 
The GT3X+ product represents the next generation of ActiGraph actigraphy devices.  The device architecture is different 
than other products sold by ActiGraph in the following ways: 

Data Collection 
During initialization, the user chooses the raw data sample frequency (30Hz up to 100Hz in 10Hz increments).  The 
GT3X+ collects data from all on-board sensors in raw data format (see Available Channels (Modes) for more 
information).  Data recorded includes: 

• Vertical Axis Activity Acceleration Data (Axis 1) 

• Horizontal Axis Activity Acceleration Data (Axis 2) 

• Perpendicular Axis Activity Acceleration Data (Axis 3) 

• Ambient Light (Lux) 

Although Steps and Inclinometer are not directly measured during data collection, these values 
can be derived from the 3-axis data during *.gt3x file decompression. 

mailto:support@theactigraph.com�
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Unlike other ActiGraph products (GT3X, ASM, or ActiTrainer), the GT3X+ does not filter or accumulate data into epochs.  
Raw data is collected at the selected sample rate and is post-processed in the ActiLife5 software.  Because the GT3X+ 
collects data from all sensors at all times, users can generate native ActiLife *.agd files containing any desired 
combination of parametric data at a later time.  This helps facilitate backward compatibility and enhances the flexibility 
of the data by allowing users to compare data to studies which use different filter techniques or accumulation sizes (e.g., 
1 second epochs versus 60 second epochs). 

 

Figure 3 - GT3X+ Raw Data Collection and Processing 

Water Resistance 
The GT3X+ is water resistant in accordance with IEC 60529 IPX7, or immersion in one (1) meter of water for up to 30 
minutes 

Battery 
All Actigraph devices use a lithium ion rechargeable battery.  All batteries have a maximum voltage of 4.18 volts.  At 3.1 
volts ActiGraph devices enter a low voltage mode state. 

In order to slow the aging of the Lithium Ion battery, it is recommended that devices be stored in a partially charged 
state (40 – 60%) in low ambient temperatures.  Figure 4 demonstrates the impact of storage temperature and charge 
state on battery long term capacity. 

 
Figure 4 - Lithium Ion Storage 
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Each device uses a slightly different Amp hour (Ah) battery and battery life (Days): 

ASM & GT3X+:  150 mAH 8 Days* 

GT1M:   330 mAH 15 Days 

GT3X:  420 mAH 21 Days* 

ActiTrainer: 400 mAH  8 Days* 

*The battery life is affected by number axis turned on except for the GT3X+, which is impacted by the user’s selected data sample rate. 

Figure 5 shows the battery life profile for all ActiGraph devices.   Table 3, Table 4, and Table 5 show the GT3X+ battery 
life estimates based on sample rate and usage profile.  These tables also illustrate the memory limitations for those 
sample rates.  That is, the maximum number of days that the memory store.  Red cells indicate the predominant limiting 
factor for a given sample rate.  Table 3 represents the battery life/memory capacity for a 66 percent data collection duty 
cycle (16 hrs actively collecting data; 8 hrs inactive).  Table 4 represents the battery/memory capacity when the GT3X+ is 
active 24 hrs per day (e.g., during shaker table testing).  Table 5 shows the GT3X+ battery life after the device has been 
in delay-before-start mode for ten days. 
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Figure 5 – Battery Life3

 

 Profiles 

Note: If a computer is not available or if multiple devices need to be recharged, a self-powered 
USB hub can be used.  

IMPORTANT: ActiGraph devices do not come fully charged from the manufacturer.  It is 
recommended that the units be charged fully before their initial use. 

                                                            
3“Profile” for all devices assumes a 67% active duty cycle (actively collecting data 67% of the time and in Low Power Mode (LPM) 
33% of the time).  For the ActiTrainer, ActiSleep, GT3X, and GT1M devices, the profile assumes devices are recording Activity 
and Step Count data in single axis mode at 60 second epoch resolution (GT3X+ profile assumes a sample rate of 80 Hz).  For the 
GT1M, GT3X and ASM, it is assumed that the LED is not on.  For the ActiTrainer, it is assumed that the OLED display is on. 
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Sample Rate (Hz) Battery Life (Days) Memory Limit (Days) 

30 19.68 21.35 

40 17.98 16.01 

50 16.10 12.81 

60 13.75 10.68 

70 13.79 9.15 

80 12.92 8.01 

90 10.80 7.12 

100 10.56 6.41 
Table 3 – GT3X+ battery life based on 16 Hrs Active, 8 Hrs sleep. 

Sample Rate (Hz) Battery Life (Days) Memory Limit (Days) 

30 14.63 21.35 

40 13.38 16.01 

50 12.08 12.81 

60 10.19 10.68 

70 10.04 9.15 

80 9.38 8.01 

90 7.94 7.12 

100 7.81 6.41 
Table 4 – GT3X+ battery life based on no sleep (24 hrs active). 
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Sample Rate (Hz) Active Recording Time (Days) Memory Limit (Days) 

30 14.06 21.35 

40 12.84 16.01 

50 11.50 12.81 

60 9.82 10.68 

70 9.85 9.15 

80 9.23 8.01 

90 7.71 7.12 

100 7.54 6.41 
Table 5 – Active Mode Battery Life after a 10 day Delay Mode period. 

Low Voltage Mode (HALT) 
ActiGraph devices enter a “Low Voltage Mode” (or HALT) state when the battery discharges to 3.1V during normal 
operation.  This mode helps ensure that all accelerometer data is consistent across the discharge profile of the battery 
by stopping all data collection before the accelerometer reference voltage of 3.0V is reached.  In this mode, all 
important variables are stored in flash memory so as to secure the device download. 

Because the device’s internal clock stops in HALT mode, the device cannot be recharged and redeployed.  The device 
must be downloaded and reinitialized to continue use.  ActiTrainer devices will display a “HALT” symbol on the OLED 
display.  Other devices will flash the LED three times to indicate the HALT (low voltage) state. 

Impact of Multiple Modes on Battery Life for non-GT3X+ Devices 
Unlike the GT3X+, the ASM, GT3X, and ActiTrainer devices filter and accumulate raw data on the device itself (see Raw 
Data section).  Although each device is capable of collecting multiple data channels, selection of those items must occur 
at the time of initialization and cannot be selected during post processing.  Adding other parameters to the data 
collection does impact the battery life somewhat.  The impact on battery life varies by device model due to the specific 
battery capacity. Below is a quick break down on the effect of having all three axes turned on versus just the single axis. 

ASM: from 8 to 5 days 

GT3X: from 20 to 15 days 

ActiTrainer: from 19 to 14 days 
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Recharging and LED Decoding 
Recharging is automatic and is accomplished by connecting the device to a standard USB port. Charging time will depend 
on the battery life, but typically will not exceed four hours for a fully depleted battery. Once the battery is completely 
charged (max voltage of approximately 4.18V), the LED light will remain illuminated.  If the battery voltage drops below 
3.1 volts while in use, the Actigraphs will not have sufficient power to collect data and will warn the user through a 
series of coded flashes (see Table 6 and Table 7).  The battery level, reported in volts, can be viewed at any time by 
starting ActiLife and plugging in the device. 

Important: The ActiLife 5 software will not allow initialization if the voltage is below 3.82 volts. 

ActiGraph GT3X+ Connected to PC 
Red LED (Fault Indicator) 

2 Flashes Li-Ion Battery is Faulty 

3 Flashes 
A hardware failure occurred while recording data.   
Contact customer support at support@theactigraph.com 

Green LED  
1 Flash Battery Charging 

Multiple Flashes Communicating with PC via USB 

Steady On Battery Fully Charged 

ActiGraph GT3X+ Not Connected to PC 

Red LED (Fault Indicator) 
No Flashing 

(LED Off) 
Normal operating condition or battery dead 

2 Flashes 
Low Battery (use ActiLife Lifestyle software to check for remaining battery life). The 
unit needs to be recharged. 

3 Flashes 
- Unexpected Battery Failure (Temporary battery power loss) 
                   or 
- Battery Level has fallen below 3.1V and the unit has entered Halt Mode 

Green LED 

No Flashing 
(LED Off) 

Actively collecting data (“Flash Mode” disabled) or battery dead 

1 Flash 
- Delay before start mode (the LED always flashes prior to starting data collection) 
- Actively taking data ("Flash Mode" enabled – not recommended) 

2 Flashes N/A 

3 Flashes 
- End of memory reached (Device no longer collecting data) 
- Battery  died while unit was in delay before start mode (no data collected on 

device) 
Note:  The Red LED will ALWAYS flash to indicate LOW BATTERY regardless of whether "Flash Mode" is enabled or disabled.  If 
a “stop time” (optional) has been reached, the Green LED will stop flashing all together regardless of its previous state. 

Table 6 – GT3X+ LED Reference Table 

mailto:support@theactigraph.com�
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ActiGraph GT1M/ASM/GT3X Connected to PC 
1 Flash Li-Ion Battery is Charging 

2 Flashes Li-Ion Battery is Faulty 

Steady On Battery Charged 

ActiGraph GT1M/ASM/GT3X Not Connected to PC 

Not Flashing 
(LED Off) 

Actively collecting data (“Flash Mode” Disabled) or dead battery 

1 Flash 
- Delay before start mode (the LED always flashes prior to starting data collection) 
- Actively taking data ("Flash Mode" Enabled – not recommended) 

2 Flashes 
Low Battery (use ActiLife Lifestyle software to check for remaining battery life) The 
unit needs to be recharged 

3 Flashes 
- End of memory reached (Device no longer collecting data) 
- Battery  has fallen below 3.1V  and the unit has entered Halt mode (unit has 

stopped collecting data 
Note:  The LED will ALWAYS flash to indicate LOW BATTERY regardless of whether "Flash Mode" is enabled or 
disabled.  If a “stop time” (optional) has been reached, the LED will stop flashing all together regardless of its 
previous state. 

Table 7 – GT1M/GT3X/ASM LED Reference Table 

Low Power Modes 
All ActiGraph activity monitors support a low-power mode (LPM) in which the device automatically reduces power 
during periods of sedentary activity.  LPM is activated when the unit records no activity for 60 seconds (every 10 seconds 
for the GT3X+ product).  The device’s power consumption in LPM is reduced significantly and can extend the battery 
charge life of the unit by approximately 15% if the unit is left untouched4

  

.  Upon entering LPM, the device will “wake up” 
every second (1000 milliseconds) and check for movement in the X and Y direction.  If any movement is detected, LPM is 
switched off and the unit resumes normal operation.  At this time, there is no way to disable this feature. 

                                                            
4 15% battery charge life is subject to change based on firmware updates as improvements are constantly being made to enhance the 
battery life of the devices. 



 

24 | P a g e  

15 W. Main St.             Pensacola, FL 32502              tel 850.332-7900             fax 850-332-7904 
 

 

Memory Size and Data Storage  
All ActiGraph devices contain flash based, non-volatile memory.  All data is retained in spite of complete power loss due 
to battery drain. Table 8 shows the memory capacity for all ActiGraph products.   

Device Serial Number Prefix5 Memory Capacity  Available Channels 
PULxA, PULxB, PULxC, PULxD 

(ActiTrainer) 
1MB 

• 2-Axis 
• Lux 

PULxE, PULxF 
(ActiTrainer) 

4MB 
• 3-Axis 
• Lux 
• Inclinometer 

LYNxA, LYNxB, LYNxC 
(GT1M) 

1MB • 2-Axis 

LYNxD 
(GT1M) 

1MB or 2MB6 • 2-Axis  

MATxA 
(GT3X) 

4MB 
• 3-Axis 
• Inclinometer 
• Lux 

MATxC 
(GT3X) 

16MB 
• 3-Axis 
• Inclinometer 
• Lux 

MIDxA, MIDxB 
(ActiSleep Monitor) 

4MB 
• 3-Axis 
• Inclinometer 
• Lux 

NEO 
(GT3X+) 

256MB 
• 3-Axis 
• Inclinometer 
• Lux 

Table 8 - Memory Capacity and Available Channels 

The following tables outline the total recording time (in days) due to memory limitations for each of the products outline 
in Table 8.  Note that GT3X+ device memory capacity can be found in the battery life/memory capacity table breakdown 
in Table 3, Table 4, and Table 5.

                                                            
5 “x” can be any number 
6 Only limited number of 2MB versions sold – contact ActiGraph for more information 
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Table 9 – GT1M Memory Capacity 

 

Table 10 – GT3X (4MB) Memory Storage Matrix 
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Table 11 – GT3XE (16MB) Memory Storage Matrix 
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Table 12 – ActiSleep Monitor (ASM) (4MB) Memory Storage Matrix 
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Table 13 - ActiTrainer (2-Axis, 1MB) Memory Storage Matrix 
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Table 14– ActiTrainer (3-Axis, 4MB) Memory Storage Matrix
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Getting Started: 

Downloading and Installing 
Download ActiLife5 from http://www.theactigraph.com/actilife to a known location.  Double-click the icon to start the 
installer.  After running the ActiLife5 installer, follow the installation instructions in the on-screen prompts.  Note that 
you will be given an option to leave older versions of ActiLife installed.  See “Older Versions” section for details about 
leaving an older version of ActiLife installed. 

 
Figure 6 – ActiLife5 Setup Icon 

IMPORTANT: Please be sure to remove any ActiGraph devices that you have connected to your 
computer during installation.  Failure to do so could result in a faulty installation of your ActiLife 
software. 

After installing ActiLife, an icon similar to the one shown here will appear on your desktop.  Double click the icon to start 
ActiLife5. 

 
Figure 7 – ActiLife5 Program Desktop Shortcut 

Older Versions 
During the install process, ActiLife5 will search for older versions of ActiLife.  If detected, a prompt similar to the one 
shown in Figure 8 will appear.  Older versions, if kept, will no longer communicate with your ActiGraph devices. ActiLife5 
uses a completely different set of device drivers to communicate with ActiGraph devices.  These drivers cannot reside on 
the same PC with drivers from the older versions of ActiLife.  If users elect to leave an older version installed, the older 
version can only be used process downloaded DAT files using legacy macros.   

http://www.theactigraph.com/actilife�
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Figure 8 – Prompt during Installation to Leave Older Version 

Licensing 
ActiLife software is a licensed program and requires that an authorization key be obtained before the software can be 
used.  If you have not purchased an ActiLife license, you may do so by visiting our store at www.theactigraph.com/store.  
If you have misplaced your license number, contact ActiGraph sales support at support@theactigraph.com in order to 
proceed.    

Activation over the Internet 
The first time the program is launched, users will be presented with a screen similar to that shown in Figure 9.  If you 
have already received a serial code with your ActiLife Pro or ActiLife Lite software, type that serial code in the box 
provided.  If the license is accepted, a green check mark will appear to the right of the license box.  Click ‘Continue’ to 
activate ActiLife.  After activation, a screen similar to the one shown in Figure 10 will be displayed.  This screen 
summarizes the product type and the number of activations used and available, as well as the name and contact 
information of the person to whom the license is registered. 

 
Figure 9 – ActiLife Activation Screen 

http://www.theactigraph.com/store�
mailto:support@theactigraph.com�
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Figure 10 – ActiLife Registration Confirmation 

Activation without an Internet Connection 
For users without an internet connection, ActiLife can be activated by contacting our technical support staff either via 
email (support@theactigraph.com) or over the phone (1-877-497-6996 option 1).  Similar to the Internet activation, 
enter in ActiLife’s serial number in the first box that appears after launching the program.  After clicking “Continue,” a 
screen similar to Figure 11 will appear.  Provide the 24-character installation code to ActiGraph customer service 
representative.  After validating the activation code, the representative will provide a confirmation code.  Type or 
copy/paste the confirmation code into the box provided.  Click ‘Next’ to activate ActiLife. 

 
Figure 11 – Non-Internet Activation 

mailto:support@theactigraph.com�
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ActiLife 5 Tour 
ActiLife 5 contains a quick tour package highlighting the major changes and improvements in the program.  This tour 
starts automatically when the program is first opened, and we highly recommend spending a few minutes taking the 
tour. 

 

 
Figure 12 – ActiLife Tour Screen 

To replay the tour at any time, select the ‘Help’ tab in the menu bar and then select ‘ActiLife Tour’ as shown in Figure 13. 

 
Figure 13 – Run Tour from Help Menu 

ActiLife Data Formats 
To better handle the large amount of data collected by newer ActiGraph devices, ActiLife5 stores data in SQLite Format 
(with an *.agd file extension), which is essentially a small database.  ActiLife can import data from older DAT file format 
to the new AGD format by selecting “File->Import/Export” and selecting the appropriate action from the menu (see the 
ActiLife Main Menu discussion section in this manual).  Multiple files can be imported simultaneously. 
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ActiLife Main Menu 
The ActiLife main menu contains four menu options to help users interface with any ActiGraph product.  ActiLife5 
promotes backward compatibility with all of ActiGraph’s products.  The menu options available in ActiLife are meant to 
help improve our users’ experiences and provide for the multitude of needs with regards to data processing. 

File Menu 
The file menu in ActiLife contains options related to file manipulation, AGD file analysis, and template loading and 
editing. 

 
Figure 14 – ActiLife File Menu 

Import/Export 
As discussed previously, users can import and export file formats to various formats to meet nearly any need.  For 
details about the various file formats, see details in Appendix A – File Types in ActiLife5.  The table below explains the 
Import/Export options that are shown in Figure 15.  Note that in versions 5.5.0 and later, raw data collected at 30Hz can 
be exported to produce a post-filtered and post-accumulated file.  This includes 30Hz data collected on GT3XE and older 
devices. 

Epoch to Epoch 
• Imported files in this category contain epoch level data (e.g., 1s, 5s, 10s, 30s, 60s epochs). 
• Exported files also contain epoch level data in the new file format. 
• Use these options to simply switch file types (file extensions). 

Raw to Epoch 

• Imported files in this category contain raw, 30Hz data or contain binary compressed data 
(*.gt3x format).  Note, 12Hz import files are not allowed.  See Uncompressing *.gt3x Files for 
details. 

• *.DAT files are file types used in ActiLife version 4. 
• Exported files in this category contain epoch level data (e.g., 1s, 5s, 10s, 30s, 60s epochs). 
• Exported files are first filtered then accumulated 
• Supported export file formats include .CSV, .AGD, .DAT 

Raw to Raw 
• Used to export binary*.gt3x files directly to *.csv format 
• Both import and export file formats contain raw data at whatever frequency was used to 

produce the *.gt3x file 

Re-Integrate 

• This feature is used to reintegrate epoch level post-filtered/post-accumulated *.agd files into 
larger epoch “buckets.”   

• E.g., reintegrating a 10s epoch file into a 60s epoch file. 
• Files cannot be reintegrated into smaller epoch lengths (e.g., 15s -> 10s) 
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Important: AGD file formats must be used in order to perform Wear Time Validation, Data 
Scoring, Sleep Scoring, or Graphing in ActiLife5 

 
Figure 15 – ActiLife Import/Export Menu Option 

Converting to a Data Table vs. standard .CSV 
A data table *.csv file contains separate columns with corresponding headers for each data type collected by the device 
and also includes the Vector Magnitude sum of each axis if data is collected for all three axes.  A standard *.csv file 
produced during conversion simply exports the data into *.csv format.  Column headers are not included unless that 
option is by checking “Add Column Headers to CSV” in the options menu. 

MATLAB Export Option 
In ActiLife versions 5.6.0 and later, users can export native *.AGD files to *.MAT format for easy importing into 
MathWorks Matlab® mathematical software platform. 

Re-integrating 
The “Re-Integrate AGD File” option allows users to integrate AGD files to larger epoch periods (e.g., 1 second epoch data 
collection reintegrated to 60 second epoch periods for Sleep Analysis or Data Scoring).  After selecting the file to be 
reintegrated, selected the desired epoch length as shown in and click “OK.”  The new file will be saved in the same 
directory as the existing file with an appended file name indicating the new epoch length. 
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Figure 16 – Re-integration Option 

AGD File Viewer 
The AGD File Viewer can be accessed from the File menu, by clicking “finished downloading” from the Devices grid after 
a download, or by double-clicking on an *.agd file from within Windows Explorer. 

Using the AGD viewer, users can instantly view the data they’ve just downloaded.  The AGD viewer provides a 
breakdown of activity levels (according to the stored cut points in ActiLife).  Clicking “Show Data” in the AGD viewer will 
display hour-long previews of the data in a grid format.  The hourly view can be changed by clicking the desired 
date/hour or by clicking “Next Hour->” to proceed sequentially through the hourly view.  Data can be copied from the 
grid by selecting the data and pressing “Ctrl+C.”  Data can then be pasted by pressing “Ctrl+V” in MS Excel® or any text 
editor. 

Data can be exported to any format directly from the AGD file viewer by clicking on “Export Data To...” above the data 
graph.  This is equivalent to selecting “Export” from the File menu. 
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Figure 17 – AGD File Viewer 

Load Template 
 The ‘Load Template’ option allows users to browse and locate an ActiLife template file (*.agt) which forces ActiLife to 
pre-defined initialization and/or download parameters to ensure consistency among all sites.  For details on using the 
template editor, see Building and Using a Template.  Once a template is loaded, details about the template including the 
template name and ‘last modified’ date will appear in the upper right-hand corner of the ActiLife tool as shown in Figure 
18. 

 
Figure 18 – Template-in-use information 
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Remove Template 
The ‘Remove Template’ option simply disables any active template that ActiLife is using.  The current template 
information as shown in Figure 18 will disappear after using this option.  For more information about the template 
feature, see Building and Using a Template. 

Template Editor 
The template editor loads the template editor form which can be used to create new or modify existing templates for 
use with all versions of ActiLife.  For more information, see Building and Using a Template. 

Note. The template editor is not available in ActiLife LITE. 

Edit Menu 

 
Figure 19 – Edit Menu 

The “Copy” and “Select All” options in the Edit menu allow users to select and copy elements in the selected grid so that 
they may be pasted into a text or spreadsheet editor.  These apply to any tab within ActiLife.  The “Options…” menu 
item allows ActiLife users to set system options that control how ActiLife functions. To change any option, make the 
change then click ‘Apply’ in the Options panel.  Click ‘OK’ to close the panel. 

General Options 

Update Options 
Checking “Check for Program Updates” enables ActiLife’s auto-update feature and allows ActiLife to check for program 
updates via the Internet when the program starts up.  If an Internet connection is unavailable, ActiLife automatically 
skips this step.   

Important: It is strongly recommended that this option remain checked.  Doing so ensures that 
the user has the latest version of ActiLife.  Older versions of ActiLife may have bugs or issues 
which could affect data collection.  ActiGraph makes every effort to ensure that data collection 
and download are unaffected during program updates 

Each time a device is initialized, ActiLife checks the firmware version on the device.  If it is not the latest version available 
from ActiGraph, it is automatically loaded onto the device prior to re-initialization.  Because all data on a device is 
deleted prior to flashing firmware, firmware updates are only performed just prior to re-initialization during which time 
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the device is fully erased.  The “Update Firmware on Initialization” option allows the user to disable this feature.  
However, in order to guarantee that all devices remain up to date, this feature is permanently checked and enabled and 
cannot be unchecked.  In order to disable this feature, contact ActiGraph support at support@theactigraph.com.   

It should be noted that ActiLife automatically downloads the latest version of firmware (for all ActiGraph devices) each 
time the program loads.  In this way, ActiLife makes every effort to keep users updated with the latest firmware for their 
devices.  The latest firmware files can be found in the C:\Users\<user 
name>\Documents\ActiGraph\ActiLife\FirmwareFiles directory.   

ActiLife ships with the latest versions of firmware available in an effort to ensure that our offline customers remain 
updated. 

Units of Measurement 
Use these options to select the desired units of measurement throughout the ActiLife software.  If “English” is selected, 
users have the option to display subject height information in inches or Ft/Inches. 

Timespan Display 
The Timespan Display settings set the default view for the ‘Current Data Recorded’ display in the Devices grid.  Selecting 
“Hours/Minutes/Seconds” breaks the display into three parts (hours, minutes, and seconds).  Checking “Show text for 
‘H’ ‘M’ and/or ‘S’” annotates the time with letters corresponding to hours, minutes or seconds (e.g., 820m versus 820 – 
useful for copy/pasting into a text or spreadsheet editor that may not use the h/m/s notation). 

Directories 
Use this option to set the default directories for data downloads, firmware storage, and CSV file creation 

Downloading 

Download Naming Convention 
These options set the default naming convention for downloaded files.  During the download process, users have the 
option to change this option. 

Create File Options 

Create DAT and CSV with AGD Download 
Use these options to create a *.dat or *.csv file at the time of download.  Important: These options only work whenever 
an AGD file is created.  Hence, when downloading a GT3X+ device, *.dat and *.csv files will not be created when these 
options are checked unless the “Create AGD File” is checked during the download process (see Downloading GT3X+ 
Devices for details on creating an AGD file on download). 

Add Column Headers to CSV 
Checking this option will add column header labels to the columns in CSV files when those files are created via export 
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Compress GT3X+ Files 
This option will apply maximum file compression to *.gt3x files when they are downloaded from GT3X+ devices.  This 
compression can greatly reduce the file size of the *.gt3x zip files, but can double the post-processing time (i.e., the time 
it takes to create an *.agd file from a *.gt3x file).  For details on post-processing, see Uncompressing *.gt3x Files. 

Scan of GT3X+ Downloads 
When downloading GT3X+ data, this option allows users to be notified of large gaps (null data, or 0s) in the data which 
may indicate either a problem with the device itself or non-compliance with the device end-user.  Setting this option to a 
certain percentage will prompt the user if there are more than that percentage of the data contains 0s.  For example, 
setting to 10% will cause notifications to appear when 10% or more of the data on the device contains null data (0s).  Set 
this option to 100% to disable notifications. 

Wear Time Validation 
Wear Time Validation options are used to set the default values for the dataset filters in the Wear Time Validation tool. 

Cut Points 
The Cut Points option is used to set the default cut point levels and names as part of the Cut Point scoring feature in the 
Data Scoring tool.   

Note: In ActiLife versions prior 5.4, “Light” and “Lifestyle” levels were incorrectly labeled.  In 
versions 5.4 and later, click “Restore Factory Defaults” to correctly label the cut points. 

Bouts 
The Bouts option is used to set the default bout settings for the Bout scoring feature in the Data Scoring tool. 

Children’s METs 
The Children’s METs option is used to set the default cut point levels and names as part of the Children’s METs scoring 
feature in the Data Scoring tool. 

Sleep Scoring 
The Sleep Scoring option allows the user to set the default Sleep Scoring Formula for the Sleep Scoring Tool.  See Sleep 
Scoring Algorithms for more information. 

Colors 
The Colors option allows the user to set the default colors for all graphing items in ActiLife. 
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Communication Menu 

 
Figure 20 – Communication Menu 

Show Download Folder 
The Show Download Folder simply opens ActiLife’s default download folder.  This option is useful for locating files 
downloaded from devices in the Devices tab. 

Show CSV Folder 
The Show CSV Folder opens the default CSV conversion/download folder 

Update Firmware from File 
Within the “Advanced” menu, the Update Firmware from File option allows users to manually upgrade (or downgrade) 
device firmware.  From the Devices tab, select the devices that need to be upgraded then select the Update Firmware 
from File option.  A dialog box will allow the user to select a firmware file for each of the connected devices types.  After 
the file has been selected, click “OK to update the firmware. 

Important: Manually upgrading or downgrading firmware is not recommended.  Doing so could 
render your ActiGraph device unusable and could void the product’s warranty.  Contact ActiGraph 
support prior to manually changing the firmware.  Under normal circumstances, ActiLife will 
automatically update the devices firmware. 

Help Menu 

Online Support 
Click this option to access our online support system 

ActiLife Tour 
This option launches the ActiLife introduction tour that appears on first-install. 

Deactivate 
ActiLife licenses are node locked to the machine on which the software is installed.  Users are allotted a specific number 
of activations on various machines.  In order to prevent losing an activation, ActiLife should be deactivated before 
ActiLife is uninstalled and removed from its host computer.  To deactivate ActiLife and reclaim the activation, select the 
Deactivate option, and type “DEACTIVATE” in the box provided.   
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Figure 21 – Deactivating ActiLife 

Prior to deactivating, be sure to click “View Activation Details.”  Write down the Registered Serial Number shown.  This 
number will be required to reactivate ActiLife5 

Click “Deactivate” to complete the deactivation.   

About ActiLife 
The About ActiLife option displays information about the ActiLife program including a link to ActiGraph’s corporate 
website, copyright information, and the software version number. 
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Device Initialization and Download 
Once ActiLife is properly installed and licensed, users will be presented with the “Devices” screen similar to the one 
shown in Figure 22.  ActiLife5 is capable of initializing or downloading multiple devices simultaneously.  Devices can be 
connected either before or after ActiLife5 is launched.  

 
Figure 22 – Opening Screen 
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As shown in Figure 23, device status information will appear in the “Devices” tab as devices are connected to the 
computer.  ActiLife5 can handle up to 127 devices at one time, although computer limitations may decrease that 
number.  Device status information is provided in the Devices grid. 

Device 
The “Device” column describes the device connected to the PC.  This could be any of the products offered by ActiGraph.  
Mixing devices is allowed. 

Serial # 
The “Serial #” column displays the serial number of the device connected. 

Status 
The “Status” column displays the current status of the attached device.  The status could be “Idle,” “Initializing,” 
“Finished Initializing,” “Updating,” “Downloading,” or “Finished Downloading.” 

Progress 
The “Progress” column contains the progress bar indicating the progress toward completion of the status indicated in 
the “Status” column. 

Firmware 
The “Firmware” column displays the current firmware version on the device.  Firmware is automatically updated during 
initialization.  See Update Options for more details. 

Battery Voltage 
This column displays the battery voltage on the device.  For more information, see Battery. 

Total Memory 
The total memory available on the device 

Current Data Recorded 
This column displays the current number of days, minutes, and seconds of recorded data on the device.  To adjust how 
this appears, see Timespan Display. 

Epoch/Sample Rate 
For non-GT3X+ devices, this column represents the accumulation epoch length.  For GT3X+ devices and non-GT3X+ 
devices in raw data collection mode, this column represents the sample/store rate. 

Subject Name 
This column displays the subject name currently stored on the device. 

Start Date & Time 
This column displays the start date and time programmed on the device. 
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Stop Date & Time 
This column displays the stop date and time programmed on the device.  This is set during initialization and is used to 
align the file lengths for multiple devices during large longitudinal studies. 

Filter 
The “Filter” column displays the on-board accelerometer filter setting for initialized devices (Normal or Low-Frequency-
Extension).  See Setting Device Parameters for details.  This column is not applicable for GT3X+ devices as no on-board 
filtering is performed. 

Axis Enabled 
The “Axis Enabled” column indicates which axes are being sampled and stored.  1 – only vertical (Axis 1); 2 – vertical and 
horizontal (Axes 1 and 2); 3 – vertical, horizontal, and perpendicular (Axes 1, 2, and 3). 

Modes 
The “Modes” column displays icons representing the data channels that the device is set to log (if initialized).  The icons 
and their meanings are interpreted in Table 15. 

Mode/Channel 
Icon 

Interpretation 

 

Flash LED Mode Enabled  
(LED flashes periodically to indicate device 

is active).  See Recharging and LED 
Decoding for more details. 

 

Step counting enabled. Indicates that the 
device is recording step counts per epoch.  

See Steps for more details. 

 

Inclinometer enabled. Indicates that the 
device is recording orientation data which 

will later be interpreted as sitting, standing, 
lying, or off.  See Inclinometer for more 

details. 

 

Lux (ambient light) sensor enabled.  
Indicates that the device is collecting light 

data.  See Lux (Ambient Light) for more 
details. 

Table 15 – Mode/Channel Icon Definitions 

More Info 
The button in the “More Info” column is for debug purposes by ActiGraph support and should not be required to 
operate the device(s). 
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The data in the Devices grid can be copied and pasted into any text editor by clicking on a cell, pressing and holding the 
Shift key and clicking on another cell to select a group of cells then pressing “Ctrl+C” to copy the data to the PC 
clipboard.  This can be useful for studies in which device data must be logged. 

 

 
Figure 23 – Devices Screen Showing Multiple Actigraphs 

IMPORTANT: Device drivers must load the first time a device is connected to a USB port.  Devices 
may take a few seconds to load during device driver enumeration. 

Initializing Devices 
Select check box corresponding to the devices to be initialized (or check “Select All Devices”) and click “Initialize.”  A 
dialog similar to Figure 24 will appear. 

Setting Device Parameters 
The ‘Initialize Device(s)’ screen contains a separate tab for each type of ActiGraph device connected to the PC and 
appears after clicking the “Initialize” button at the top of the “Devices” screen.  Tabs across the top represent the types 
of devices to be initialized.  If multiple devices of each type are selected, the tab group applies to all devices of that type. 
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Select the tab for the type of device you wish to configure and set the specific data collection parameters.  Filter 
information can also be set at the time of initialization.  For more details about the low frequency extension, see Low 
Frequency Extension.  All ActiGraph devices of the same type that are initialized simultaneously will be initialized with 
the same data collection parameters.   

Start Date and Time and Stop Date and Time apply to all devices and cannot be unique for each device group.  Stop time 
is optional. 

The “Max Recording Time” for each device is shown in the Initialization screen.  This number will change depending 
upon the number of axes selected, the epoch length, and the number of active channels (see Available Channels 
(Modes) for details of the meaning of each setting).  Most devices’ “Max Recording Time” will far exceed the battery life 
of the device. 

The icon in the top right corner of the initialization screen indicates which axes are selected.  As the “# of Axis” 
dropdown box is increased, so too are the number of logged axes.   

GT3X+ devices collect data from all channels regardless of initialization settings.  The only settings available for the 
GT3X+ are the raw Sample Rate and the “Flash LED” option as shown in Figure 24. 

After data collection parameters have been set up for each model, select the ‘Enter Subject Info…’ button. 

 
Figure 24 – Initialize Device Screen (GT1M on the left; GT3X+ on the right) 
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Subject Info 
The Subject Name screen allows users to enter a unique subject name for the attached devices.  This data will be stored 
on the device and will be available at download and can help with file naming when data is downloaded from the device.  
To add or change a name, highlight the subject name cell.  Note that ActiTrainer devices (devices with serial numbers 
beginning with ‘PUL’) will store more information.   

 
Figure 25 – Subject Name Entry Form 

If desired, the “Use Serial Number” button will populate the Subject Name column with the serial number of the device.  
Similarly, the “Use Device Info” button will automatically populate the Subject Name column with the Subject Name 
currently stored on the device.  The “Clear” button will erase the fields for easier editing. 

Important: If any devices have a voltage less than 4.1 volts, we recommend 
leaving them connected, allowing them to charge fully in to charge fully if time 
allows. Updated voltage can be viewed by selecting the ‘Refresh All’ tab (or F5) 
from the devices screen. 

GT3X+ Biometric Info Storage 
GT3X+ Devices (NEOxxxxxxxxxx) can optionally store extra biometric information during initialization which can be used 
for post-processing after downloading data from the device (see Figure 25 for details).  GT3X+ devices can store the 
following information in addition to the “Subject Name” which is standard on all devices: 

• Gender – Male or Female 

• Height – Subject height in inches or ft. /inches depending upon the settings. 

• Weight – Subject weight in lbs. or kg, depending upon the settings. 

• Date of Birth – Subject’s date of birth (mm/dd/yyyy) 
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• Race – Subject race: Asian/Pacific Islander, Black/African American, White/Caucasian, Latino/Hispanic, Other 

• Limb – The limb on which the device is worn: Wrist, Waist, Ankle, Upper Arm 

• Side – The side of the body that the patient is wearing the device.  Left or Right 

• Dominance – Dominant or Non-Dominant.  This allows the researcher to store whether or not the wear location 
is on the subject’s dominant or non-dominant side. 

This data is stored in the info.txt file as part of the *.gt3x zip file when data is downloaded from the GT3X+ device. 

When all names have been entered, select the ‘Initialize All’ button and the progress is displayed in the ‘Status’ column 
(refer to Figure 23).  When the initialization is complete, the devices are ready to be removed.  

Downloading Devices 

File Format 
Downloading data from your device is a simple process.  It is important to understand how the data on the device is 
formatted and what is contained in the file.  Except for GT3X+ devices, ActiLife stores data from the devices into the 
*.agd file format upon download.  This file format is compatible with the popular open source database SQLite 
(http://www.sqlite.org/).  The *.agd file schema can be found in Appendix A of this users guide. 

Downloading GT1M, GT3X, ASM, and/or ActiTrainer Devices 
To download data from GT1M, GT3X, ASM, or ActiTrainer devices, connect your device(s) to the computer – ActiLife will 
detect those devices and they will appear in the Devices grid.  Select (check the box) the devices that need to be 
downloaded and click “Download” at the top of the screen.  The Download Options screen will appear allowing you to 
select the type of naming convention you would like.  The names can always be changed later or you can select ‘Prompt 
for Each Download’ to enter unique names for each downloaded device.  These options help to prevent name 
duplication during batch downloading. 

 
Figure 26 – Download Options Window 

http://www.sqlite.org/�
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To select a different download location, select “Select Download Location…” and browse to the desired download 
directory.  To make this directory the default download directory, check the box below the download location in the 
Download Options prompt.  This can also be changed by selecting the directory from the “Edit->Options->Directories” 
setting in the program’s main menu.   

Saving Biometric Data during Download 
During the download process, ActiLife gives the user the option to store metadata information associated with each 
device and corresponding device wearer.  After clicking ‘Download’ from the devices grid, check the box entitled “Add 
biometric and user information” to expand the details grid below the download form.  This form is shown in Figure 27.  
All of the fields shown here are optional. 

Subject Name 
Unless it is changed, the” Subject Name” will default to the subject name used to initialize the device.  Even if the 
biometric and user information grid is not expanded for population, the “Subject Name” will be stored with the *.gt3x or 
*.agd file upon download.  From this grid, the “Subject Name” can be changed prior to downloading. 

Gender 
Click the “Gender” column to reveal a dropdown menu.  Select Male or Female.   

Height 
Use the “Height” column to enter the subject’s height in inches, centimeters, or feet/inches.  Select a different format by 
changing the Units of Measurement in the Options menu. 

Weight 
Use the “Weight” column to enter the subject’s weight in lbs or kg.  Select a different format by changing the Units of 
Measurement in the Options menu. 

Date of Birth 
Use the “Date of Birth” column to edit the subject’s date of birth.  A calendar picker is provided, but it is probably more 
convenient to simply type in the subject’s birthday.  The date format is mm/dd/yyyy. 

Race 
Use the “Race” column to select the subject’s race.  Select “White/Caucasian,” “Black/African American,” 
“Latino/Hispanic,” or “Pacific Islander 

Limb 
Use the “Limb” column to select where the device was worn.  Options include “Wrist,” “Waist,” “Ankle,” “ 

Side 
Use the “Side” column to specify the device wear location (left or right side of the body).. 
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Dominance 
The “Dominance” option allows users to specify whether the wear location side was the subject’s dominant or non-
dominant side. 

 
Figure 27 – Biometric and User Information during Download 

Custom Fields 
When custom fields are collected as part of a template (see Building and Using a Template for more details), those 
custom fields will appear in the metadata grid as shown in Figure 28.  Additionally, the “Add Biometric and User 
Information” check box option will be permanently selected and entry of the custom fields will be required. 

 
Figure 28 – Custom Fields in the Biometric and User Information grid 

 

Clicking “Download All Devices” from the form will download the data from the selected units and store the data in 
SQLite format stored with a *.agd file extension (See Appendix A – File Types in ActiLife5). 

ActiLife 5 no longer stores data in DAT or CSV format. To convert data into one of those formats, 

select ‘File’ tab then the Import/Export option as shown in Figure 15. 
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ActiLife can automatically create *.csv files on download by setting this in the edit menu.  Note 
that this only works for GT3X+ devices if an *.agd file is created during the download process. 

Downloading GT3X+ Devices 
Downloading data from GT3X+ devices is very similar to download from other devices.  It is important to understand the 
difference in the file handling for this device.  In order to increase the efficiency of the download process, data from 
GT3X+ devices is downloaded in raw, binary format with file extension *.gt3x (see Appendix A – File Types in ActiLife5 
explaining the *.gt3x format).  This binary format mirrors the proprietary compressed raw data format stored on the 
device itself and is unreadable by standard text editors.  These files (*.gt3x) are in a maximum compression format and 
are optimal for emailing or FTP file sharing with colleagues.  In order to read the data or process the data with ActiLife, 
the *.gt3x files need to be uncompressed (i.e., exported to *.agd format) using ActiLife.  This can occur either during 
download or later when processing files. 

To download data from a GT3X+, select the device(s) from the grid in the Devices tab and click “Download”.  A prompt 
similar to Figure 29 will appear.  Clicking “Download All Devices” will immediately download all of the data from the 
GT3X+ into the user’s default download directory.  

Scanning of GT3X+ Data during Download 
Data downloaded from GT3X+ devices can be scanned for problems at the time of download.  At this time, ActiLife can 
scan for null data (0s) which may indicate issues with the device accelerometer or non-compliance by the end-user.  To 
enable this scanning, open the Edit->Options menu and choose the Downloading submenu.  In the “Scan of GT3X+ 
Download” section, select the warning threshold.  Doing so will warn the user during the download process if the 
number of 0s within the file exceed the threshold.  To disable this feature, set the threshold to 100%. 

 
Figure 29 – GT3X+ Download Options 
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To view the *.gt3x files, select “Communication->Show Download Folder” from the main menu in ActiLife5.  Files will 
appear in this folder as shown in Figure 30. 

 
Figure 30 – *.gt3x files 

Uncompressing *.gt3x Files 
Binary *.gt3x files can be uncompressed to *agd (for use in ActiLife), *csv, or *.dat file format.  Users have the option of 
creating *.agd files during the download process by checking “Create AGD File” from within the download prompt (see 
Figure 29).  Because GT3X+ devices record raw accelerometer data (see GT3X+ Caveats for details), the parameters for 
the uncompressed file must be set at the time of download if the “Create AGD File” option is checked.  These 
parameters include the uncompressed epoch length, the number of axes, step counting, lux (light data), inclinometer 
(standing, sitting, lying, or off detection), and/or low frequency extension.  For an explanation of these parameters, see 
Available Channels (Modes) for details. 

Important: Creating an AGD file during the download process will increase the download time 
significantly depending upon the size of the download.   

Binary *.gt3x files can be uncompressed at a later time if desired (e.g., after emailing or sharing the files).  To 
uncompress these files at a later time, select “File->Import/Export->Create AGD/CSV/DAT from Raw GT3X+” from the 
ActiLife5 main menu.  An export window similar to the one shown in Figure 31 will appear.  Individual *.gt3x files can be 
added by selecting the “Add GT3X+ Files(s)” option.  All of the *.gt3x files in a directory can be added by selecting “Add 
Directory…”  Once files are added, the desired file type(s), epoch length, and parameters can be selected within the 
export tool.  Select “Create File(s)” to export these files to the default download directory. 
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Figure 31 – GT3X+ Export Tool 

The GT3X+ export tool can also be accessed by clicking “finished downloading” hyperlink from the devices grid after 
downloading.   

 
Figure 32 – Finished Downloading Hyperlink in Devices Grid 

Another option under the ‘File’ tab is the reintegrate file. This allows users to convert data collected in smaller epoch 
files into larger epoch datasets (e.g., a 1 second epoch dataset can be converted to a 60 second epoch dataset).  
Datasets cannot be down converted (e.g., 60s to 1s).  This feature is useful if users are attempting to utilize the Sleep 
Scoring option in ActiLife5. 

After downloading data from your ActiGraph devices, the ‘Status’ column in the Devices tab will change to a hyperlink 
with the text “finished downloading…”.  Clicking this link (Figure 32) will launch ActiLife’s AGD viewer. 
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Figure 33 – “finished downloading…” link in Status column after download completed 

Building and Using a Template 
Templates were created in ActiLife version 5.5.0 to assist customers who deploy ActiGraph devices using remote 
distribution centers or who need to ensure consistency in the initialization and/or download process when multiple 
people (e.g., lab assistants) are distributing devices to patients.  Templates can be created only from within the full 
version of ActiLife (ActiLife LITE does not support template creation – only template usage).   

Once a template is created, the template can be saved as an *.agt file.  This file can then be shared via email, jump drive, 
or any other means to various distribution centers or lab partners.  Opening this file will force ActiLife to use the settings 
defined in the template editor to initialize and download devices, thus ensuring data collection consistency. 

Template Editor 
ActiLife Full users will find an option in the File menu entitled “Template Editor.”  Clicking this option will load a form 
similar to the one shown in Figure 34.  Use this form to setup the desired default initialization and download parameters 
defined below in Template Parameters. 
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Figure 34 – Initialization/Download Template Editor 

Template Parameters 

Initialization Template Options 
Use the initialization options on the left side of the template editor to force template users to use specific settings 
during the initialization process. 

Template Name (required) 
The name of the template that will appear at the top of ActiLife once the template is loaded.  An illustration is shown in 
Figure 18.  This is a required field. 

Device Selection 
Selecting “Enable Template for *****” within one or more of the device tabs will force ActiLife to use device-level 
settings during the initialization process for that particular device.   

Start/Stop Settings 
Check either Start Date/Time or Stop Date/Time to force template users to use a Start or Stop time during the 
initialization process.  Use the Day selection box to choose a forced start time offset (e.g., +0 day, +1 day, +2 days, etc) 
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and use the time selection box to set the start time.  Use “Any” in the Day selection box to give the user the flexibility to 
choose which day the device should start collecting data but the rigidity to force a start time for data collection.  If the 
template start time has already passed, ActiLife will automatically default to the next day with the same start time.  For 
example, suppose the template is set to force users to start collecting data at “+0 day(s) at: 3:00pm.”  If a user initializes 
a devices at 4:00pm, the start time will default to the next day at 3:00pm. 

The Stop Date/Time option allows the template builder to set how many days the device should collect data before 
stopping.  Note that the Day setting refers to the number of days AFTER the start time.  Again, use “Any” in this field to 
give the user the flexibility of choosing the stop date but the rigidity of using a specific stop time.  Be sure to keep the 
battery life and memory limitation considerations in mind.  For more details see the section entitled Battery.  For GT3X+ 
devices, pay particular attention to the tradeoff of battery and memory life outlined in Table 3, Table 4, and Table 5.   

Leaving either or both of the Start/Stop Settings unchecked will allow the user to select whether or not the start/stop 
times are used during the initialization process. 

Subject Name Settings 
Checking this option will force template users to use a certain convention when setting Subject Names for devices during 
the initialization process.  These options are self-explanatory with the exception of the “Static” option.  This option will 
force all Subject Names to exactly match the phrase typed here. 

Download Template Options 
Use the download options to force template users to use specific settings during the download process. 

Custom Fields 
Enable the “Custom Fields” option to force users to enter more information during the download process.  Use the “Max 
Characters” dropdown box to select the maximum number of characters allowed for this field.  This will prevent users 
from typing too many characters in this field.   

The fields entered here will appear in the download grid as shown Figure 35 after clicking “Download” from the devices 
grid.  Note that these fields must be populated before users can proceed with the download.  In most cases (without a 
template in use), the “Add biometric and user information” check box can be de-selected (all of the biometric data is 
optional – see Saving Biometric Data during Download for details).  However, when custom fields are enabled in the 
template, this is required; users are forced to enter values for the custom field parameters.  Note that the custom fields 
are always on the right-hand side of the grid.  Users may need to scroll to the right to enter the fields.   

Custom fields are stored with the *.gt3x files and/or *.agd files at download time.  When exporting *.gt3x files to *.agd 
format for analysis in ActiLife, the custom fields will be included as part of the export and will be contained in the *.agd 
file.  For details about the *.agd schema, see Appendix A – File Types in ActiLife5.  In ActiLife version 5.6.0 or later, 
custom fields appear in the AGD File Viewer. 
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Figure 35 – Custom Fields as they appear after clicking “Download” 

 

Download Settings 
Use the “Download Settings” in the download section of the template builder to force template users to utilize a specific 
file download location and/or a specific file naming convention.  By checking the “Force Download Location” and 
selecting a directory, template users will be forced to use the specific location.  Template builders can type in network 
URLs or any local directory address that may be applicable for the end-users’ specific sites.   
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Note: If the selected directory does not exist, ActiLife will attempt to create the directory (e.g., 
“C:\PatientDownloads”).  If the user does not have administrative permissions or otherwise 
cannot create the directory, this feature will automatically disable itself, thus allowing the user to 
select the directory of their choice. 

To force a file naming convention for template users, check the “Force Naming Convention” option and select the 
desired naming convention.  During the download process, file names will be of the same format selected here for those 
users using the template.  The “Concatenate Custom Fields” option will concatenate the custom field characters entered 
by the user during download time.  Multiple custom fields will be concatenated with no dashes or separation 
punctuation.  At this time, there are no options for reordering or hyphenating the file name parameters when using the 
custom field naming convention.  These features will be added in later versions of ActiLife. 

Saving and Sharing Templates 
Once the template parameters are set as desired, the template can be saved as a file and shared with other users.  Users 
can click the “Save” button in the bottom right-hand corner of the template editor or use the “File” menu to save the 
template file.  From the file menu, a template can be opened to make modifications (click “Open” then browse to the 
template file).  In addition, the template can be saved and immediately put into use by clicking “Save and Use.”  This 
option is helpful when testing the newly created template before emailing or sharing the template file. 

Once the template is saved, a new file with an *.agt file extension will be created similar to the one shown in Figure 36.  
This file can be emailed to distribution centers or shared over local networks within organizations.  Users who load this 
template will be forced to use the parameters as they were defined in the template editor. 

 
Figure 36 – Template file saved to a user’s desktop 

Loading Templates 
Once the *.agt template file has been shared, users using ActiLife (Full or LITE) can simply download the file to their local 
machine (anywhere) and double-click on the file.  Doing so will launch ActiLife and load the template.  When done 
correctly, the template name and “Last Modified” time will appear in the upper right-hand corner of the ActiLife 
software as shown in Figure 18 on page 37.  Once the template has been loaded once, the *.agt file can be removed 
from the end-user’s computer.  It is not necessary that the file remain on the user’s computer. 

An alternative way of loading a template file in ActiLife is to use the “Load Template” option in the File menu.  Browse to 
the template file location and click ‘Open’ to load the template. 
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When a template is loaded in ActiLife, the template will remain present even after closing and re-opening the software. 
This ensures that the template settings remain unchanged even when a user’s computer is shut down and restarted.  To 
remove a template, click “Remove Template” from the file menu. 

Dataset Analysis Overview 
To improve the efficiency of our customers’ research and to reduce the time spent in post-data collection analysis, we 
have included several Dataset Analysis tools in the full version of ActiLife5.  These tools include the Wear Time 
Validation tool which can be used to filter out datasets that do not meet patient wear criteria, Data Scoring which can 
be used to examine energy expenditure, bouts, and more in a particular dataset, a Sleep Scoring tool which can be used 
to analyze a patient’s sleep efficiency, and a Graphing tool which can be used to look at detailed epoch-by-epoch graphs 
of a dataset. 

Wear Time Validation 
The Wear Time Validation tool serves two purposes.  First, the tool can be used to exclude individual DAYS from dataset 
Data Scoring (next step) that do not meet hourly and daily criteria.  For instance, a researcher may place criteria on a 
patient that requires them to maintain at least 10 minutes (consecutive or non-consecutive) activity per hour (non-zero 
data) for at least 5 hours per day, the Wear Time Validation tool can automatically exclude these days from the dataset 
so that those days do not count toward activity related calculations performed during Data Scoring.  Second, the Wear 
Time Validation tool can be used to identify entire datasets that do not meet a minimum total day requirement set by 
the user.  In our previous example, suppose the researcher wants to identify whether or not any of the datasets met the 
daily requirements for at least 3 days total.  The Wear Time Validation tool will highlight (in red) those datasets that do 
not meet the 3 day minimum requirement (See Figure 37). 
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Figure 37 – Wear Time Validation Screen 

What is a dataset and what are the limitations? 
The Wear Time Validation tab performs screening on datasets.  A single dataset represents a single device download 
and may contain multiple days of data.  Datasets are specific to a device and a user.  If a user wears a device for five 
days, recharges the device and wears it again for seven days, that user’s dataset will contain 12 days’ worth of data. 

At this time, datasets cannot be concatenated.  In other words, you cannot add data to a dataset.  We are planning to 
add this feature in a future release of ActiLife. 

Adding Files (Datasets) 
Datasets are added to the Wear Time Validation tab automatically after they have been downloaded in the Device” tab.  
Alternatively, users can choose “Add Dataset” to select an individual AGD dataset to add to the tab.  “Add Directory” 
adds all the AGD files in a particular directory into the Wear Time Validation tool for processing.  Removing datasets 
works the same way.  You can remove individual datasets by highlighting a dataset and clicking “Remove Selected 
Dataset(s)” or remove all of the datasets and start again. 

Filtering Data 
Data filtering in the “Wear Time Validation” tab can be thought of as a three-stage process: 
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Stage 1: Qualification of valid hourly activity data.  Stage 1 qualifies hours as either valid or invalid based on 
minimum minute-by-minute requirements 

Stage 2: Qualification of valid days within a dataset.  Stage 2 qualifies days as valid or invalid based on the number 
of valid hours in a day determined from Stage 1 

Stage3: Qualification of an entire dataset.  Stage 3 qualifies an entire dataset as either valid or invalid (turns it red) 
based on the number of valid days as determined in Stage 2. 

Stage 1:     Valid Hourly Activity 

 
Figure 38 – Hour Qualifiers for Wear Time Validation 

Each hour in a dataset can be qualified as valid or invalid based on the settings shown in Figure 38.  The first option, 
“Minimum non-zero epochs per hour required,” sets the requirement for the minimum percentage of non-zero epochs 
within an hour.  If any hour within that dataset fails to meet that criterion, it is considered invalid.  Hours that do meet 
this criteria are considered valid wear time hours and count toward the total valid “wear time” used to qualify valid days 
(see “Valid Day Activity” below).  Alternatively, users can specify the “Consecutive minutes of zeros to be considered 
invalid.”  This feature works the same way.  The “Ignore counts above/below” option allows users to set a minimum 
and maximum threshold for “inactivity.”  For instance, ignoring counts below 100 means that those epochs with a value 
below 100 will be considered “zero” (or inactive).  Ignoring counts above 2000 means that epochs with a value above 
2000 will be also considered “zero” (or inactive). 

Note: Values of ‘0’ in the “Ignore Counts” options cause ActiLife to disregard these criteria.  
Epochs will be qualified (valid) if they contain any non-zero value. 

Example 1: 
- One-Second Epoch Dataset 
- Minimum non-zero epochs per hour required: 10% 
- Ignore counts below: 100 
- Ignore counts above: 5,000 
- Beginning at 5:00pm and going until 5:59pm on a given day, 1,000 epochs (1,000 seconds) contain counts that 

are between 101 and 4000 counts. 
- Between that same time span, the remaining epochs (2,600) contain epochs that are between 0 and 99 
- This hour would be considered VALID because 27.8% (1,000/3,600) of the epochs meet the criteria 
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Example 2: 
- One-Minute Epoch Dataset 
- Minimum non-zero epochs per hour required: 15% 
- Ignore counts below: 0 (i.e., any value is valid) 
- Ignore counts above: 0 (i.e., any value is valid) 
- Beginning at 1:00pm and going until 1:59pm on a given day, 4 epochs (4 minutes) contain counts that are 

between 0 and 100 counts 
- Between that same time span, the remaining epochs (56 minutes) contain epochs that are 0. 
- This hour would be considered INVALID because only 6.7% (4/60) of the epochs meet the criteria  

Example 3: 
- One-Second Epoch Dataset 
- Consecutive minutes of zeros to be considered invalid: 10 
- Ignore counts below: 0 (i.e., any value is valid) 
- Ignore counts above: 0 (i.e., any value is valid) 
- Beginning at 7:00am and going until 7:15am on a given day in the dataset, 600 consecutive epochs (10 minutes) 

contain counts that are between 1 and 6000 counts and 300 consecutive epochs (5 minutes) contain no valid 
data (0 valued epochs). 

- Between 7:15am and going until 7:59am on that same day, 540 consecutive epochs (9 minutes) contain counts 
with no valid data (0 valued epochs) followed by 2160 consecutive epochs (36 minutes) containing values that 
are between 1 and 4000 counts. 

- This hour would be considered VALID because there are no 10 minute consecutive spans of 0 count data 
between 7:00am and 7:59am. 

Stage 2:   Day Qualifiers 
Stage 1 sets criteria for individual hours within a dataset.  Stage 2 excludes days based on the number of valid hours 
identified in Stage 1 by selecting the “Minimum wear time per day in hours” as shown in Figure 39. 

 
Figure 39 – Day Qualifier for Wear Time Validation 

Day Qualifier Example: 
- Three-day long dataset 
- Minimum wear time per day in hours: 8 
- Stage 1 identifies day 1 as having 4 valid hours; day 2 as having 10 valid hours; and day 3 as having 7 valid hours. 
- Day 1 would be flagged as invalid 
- Day 2 would be flagged as valid 
- Day 3 would be flagged as invalid 
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After the Wear Time Validation filter has been executed (following Stage 3), individual days that are flagged as valid or 
invalid can be viewed by selecting the “Details” button corresponding to the dataset. 

 
Figure 40 – Details View Shows Epoch-By-Epoch Validation 

Details about which days are considered “valid” can be seen in the details view.  An example is shown in Figure 41.  
“Valid” days (those that will be used in further analysis) are checked as “Use.”  Users may manually over-ride the Wear 
Time Validation results by checking or unchecking individual days in the dataset.  Selecting “Save and Close” from this 
view will save any changed selections prior to exiting. 

 
Figure 41 – Check “Use” To Override Wear Time Validation Filtering 

 

Stage 3:   Dataset Qualifiers 
Datasets can be qualified as valid or invalid based on the results from Stage 2.  Three filter options are available for 
filtering entire datasets.  These options are shown in Figure 42. 

 
Figure 42 – Dataset Qualifiers for Wear Time Validation 

These settings allow the user to select day wear criteria which might exclude an entire dataset from being used in 
further analysis.  If a dataset does not meet the “minimum number of days to wear” criteria, the dataset will turn red 
(see Figure 37) indicating that this dataset should not undergo further analysis.   
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Important:  “Weekend Days” are considered Saturday and Sunday in ActiLife5 while “Weekdays” 
are considered Monday thru Friday. 

Dataset Qualifier Example: 
- Minimum number of days to wear: 6 
- Minimum number of weekdays to wear: 3 
- Minimum number of weekend days to wear: 3 
- Note that “weekend days” refer to the total weekend days available in the dataset; not the weekend days per 

week.  In this example, the dataset is 14 days long and covers two weekends or four possible weekend days. 
- Stage 2 filter settings reveal that a particular dataset that starts on Monday, January 4 contains 14 days’ worth 

of consecutive data but results in only 6 days’ worth of “valid” data 
- The “valid” days fall on 
- Wednesday, Jan 6 
- Thursday, Jan 7 
- Friday, Jan 8 
- Saturday, Jan 9 
- Monday, Jan 11 
- Thursday, Jan 14 
- This dataset would be considered INVALID because it does not meet the minimum weekend day’s requirement.  

Although the “Minimum number of days to wear” criteria of six (6) days are met, only Saturday, January 9 
qualifies as a valid weekend day. 

Running Wear Time Validation 

 
Figure 43 – Get Results Option Runs Wear Time Validation Filtering 
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Following criteria selection (Stages 1-3), the “Get Results” button (Figure 43) will analyze all datasets and return the 
results.   

Datasets with a red background are considered invalid. 

Datasets with red backgrounds (see Figure 37) are considered invalid.  That is, they do not meet the minimum dataset 
criteria defined in the “Valid Dataset” section of the Wear Time Validation tool. 

Datasets can contain invalid days and hours even when the dataset itself is valid.  See Figure 41 
for illustration 

The grid view (shown in Figure 37) shows the details of each dataset in each column, including the number of valid and 
invalid days in a given dataset.  Epoch-by-epoch details can be viewed for any dataset by selecting “Details” in the 
dataset grid view.  Doing so also gives the user the opportunity to manually include or exclude hour-by-hour data within 
each dataset.  Selecting or deselecting an hour will exclude that hour from further analysis if further analysis is 
performed within the “Data Scoring” tab. 

Saving results to Dataset 
The “Save to Dataset(s)” option in the Wear Time Validation tool will save the “cleaned” results of the applied filter to 
the validated datasets.  This will allow users to easily keep track of cleaned data.  In addition, invalid data can be 
excluded from “Data Scoring” once a cleaned dataset has been saved. 

Export to CSV 
The “Export to CSV” option exports the information in the Wear Time Validation grid to a comma separated value file for 
sharing and manipulation.  Detailed data can be exported to CSV format from the “Details” view of each dataset. 

Score and Analyze Valid File(s) 
As of version 5.3.0, this option is not yet enabled.   

 
  



 

67 | P a g e  

15 W. Main St.             Pensacola, FL 32502              tel 850.332-7900             fax 850-332-7904 
 

 

Data Scoring 
Data Scoring in ActiLife allows users to analyze the details of their dataset(s) by examining Energy Expenditure, Activity 
Cut Points, Activity Bouts, and Heart Rate Energy Expenditure.  In addition, energy expenditure in children can also be 
analyzed using Children’s MET levels.  

Date and Time Filters 
Date and time filtering allows users to isolate the data scoring to specific dates or times of interest.  Multiple filters can 
be added simultaneously to specifically target certain days or times.  To enable Date and Time Filtering, check the box 
above the filter area that says “Use Date and Time Filters.”  To add a filter, click “Add Filter.”  Filters can be stacked, but 
not overlapped.   

 
Figure 44 – Date and Time Filter 

Date and time filters can be removed by selecting the filter to remove and clicking “Remove Filter. 

  



 

68 | P a g e  

15 W. Main St.             Pensacola, FL 32502              tel 850.332-7900             fax 850-332-7904 
 

 

 

 
Figure 45 – Removing Date and Time Filters 

Energy Expenditure 
Energy expenditure in kilo-calories (kcals) can be calculated quickly and easily by adding datasets to the “Data Scoring” 
tab, entering the subject’s weight (in lbs.), selecting “Worn on Wrist” (if applicable), and clicking “Calculate Energy 
Expenditure.”  Each dataset kcal value will be summed and reported alongside the corresponding dataset.  A summed 
total will appear at the bottom of the grid for the entire dataset group.   

The “Use cleaned data if available” box is selected by default.  This setting enables data scoring only on filtered data and 
excludes invalid data (based on data filtered in the “Wear Time Validation” tool)..  Deselecting this option performs data 
scoring on the entire dataset or group of datasets regardless of validation results. 

Energy Expenditure Algorithms 
Four algorithm options are available to users.   

• Work-Energy Theorem.  This formula utilizes the physics equivalent of energy   

𝑘𝑐𝑎𝑙𝑠 = 𝐶𝑜𝑢𝑛𝑡𝑠 × 0.0000191 × 𝑀𝑎𝑠𝑠 

where 

𝑘𝑐𝑎𝑙𝑠 = 𝑇𝑜𝑡𝑎𝑙 𝐶𝑎𝑙𝑜𝑟𝑖𝑒𝑠 𝑓𝑜𝑟 𝑎 𝑆𝑖𝑛𝑔𝑙𝑒 𝐸𝑝𝑜𝑐ℎ 
𝐶𝑜𝑢𝑛𝑡𝑠 = 𝐶𝑜𝑢𝑛𝑡 𝐿𝑒𝑣𝑒𝑙 𝑓𝑜𝑟 𝑎 𝑆𝑖𝑛𝑔𝑙𝑒 𝐸𝑝𝑜𝑐ℎ 
𝑀𝑎𝑠𝑠 = 𝑊𝑒𝑖𝑔ℎ𝑡 𝑖𝑛 𝐾𝑔 
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• The Freedson Equation.  Developed by Dr. Patty Freedson in 1997, this equation is only accurate 
above 1951 counts for adults. 

𝑘𝑐𝑎𝑙𝑠 = 𝑆𝑐𝑎𝑙𝑒 × (0.00094 × 𝐶𝑜𝑢𝑛𝑡𝑠 + (0.1346 × 𝑀𝑎𝑠𝑠 − 7.37418)) 
[𝑓𝑜𝑟 𝐶𝑜𝑢𝑛𝑡𝑠 ≥ (1952 × 𝑆𝑐𝑎𝑙𝑒)] 

where 

𝑆𝑐𝑎𝑙𝑒 = (𝐸𝑝𝑜𝑐ℎ 𝑃𝑒𝑟𝑖𝑜𝑑 𝑖𝑛 𝑆𝑒𝑐𝑜𝑛𝑑𝑠 ÷ 60) 

• Combination (Work Energy and Freedson).  When selected, the combination option automatically 
uses the Work-Energy Theorem to calculate caloric expenditure below 1951 counts and the 
Freedson Equation to calculate energy expenditure above 1952 counts. 

𝑘𝑐𝑎𝑙𝑠 = �𝑊𝑜𝑟𝑘/𝐸𝑛𝑒𝑟𝑔𝑦 𝑇ℎ𝑒𝑜𝑟𝑒𝑚, 𝐶𝑜𝑢𝑛𝑡𝑠 < 1952
𝐹𝑟𝑒𝑒𝑑𝑠𝑜𝑛 𝐸𝑞𝑢𝑎𝑡𝑖𝑜𝑛,                  𝐶𝑜𝑢𝑛𝑡𝑠 ≥ 1952

� 

• Vector Magnitude.  This option uses all three axes (if data is collected on all three axes) to estimate 
energy expenditure.  The Vector Magnitude calculation is only valid if the epoch counts exceed 
the 𝑆𝑐𝑎𝑙𝑒 × 2453.  This formula was validated by Freedson in 2010.  See 
http://www.theactigraph.com/article/research-database/validation/calibration-of-the-actigraph-gt3x-activity-
monitor/ for more details. 

 

𝑘𝑐𝑎𝑙𝑠𝑉𝑒𝑐𝑡𝑜𝑟𝑀𝑎𝑔𝑛𝑖𝑡𝑢𝑑𝑒
= 𝑆𝑐𝑎𝑙𝑒 × ��0.00097 × 𝑉𝑒𝑐𝑡𝑜𝑟𝑀𝑎𝑔𝑛𝑖𝑡𝑢𝑑𝑒(𝑎𝑥𝑖𝑠1,𝑎𝑥𝑖𝑠2, 𝑎𝑥𝑖𝑠3)� + (0.08793 × 𝑀𝑎𝑠𝑠)�
− 5.01582  𝑓𝑜𝑟 𝐶𝑜𝑢𝑛𝑡𝑠 > 𝑆𝑐𝑎𝑙𝑒 × 2453 

𝑘𝐶𝑎𝑙𝑠𝑉𝑒𝑐𝑡𝑜𝑟𝑀𝑎𝑔𝑛𝑖𝑡𝑢𝑑𝑒 = 𝐶𝑜𝑢𝑛𝑡𝑠 × 0.0000191 × 𝑀𝑎𝑠𝑠  𝑓𝑜𝑟 𝐶𝑜𝑢𝑛𝑡𝑠 ≤ 𝑆𝑐𝑎𝑙𝑒 × 2453 

Important: Energy Expenditure calculations are only accurate for adults, age 
19years and up. 

Cut Points 
ActiLife5’s cut point data scoring option allows users to break out the proportion of time each dataset encompasses in 
different categories of activity.  Default cut points are defined in Table 16.  These values can be adjusted (by selecting 
“Modify Selected Cut Point”) or removed (by selecting “Remove Selected Cut Point”).  To restore default values, select 
“Restore Defaults” from the ‘Cut Points’ tab.  To add new cut points, select “Add Cut Point.” 

http://www.theactigraph.com/article/research-database/validation/calibration-of-the-actigraph-gt3x-activity-monitor/�
http://www.theactigraph.com/article/research-database/validation/calibration-of-the-actigraph-gt3x-activity-monitor/�
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Default Cut Points    Range 
Sedentary 0 – 100 Counts 
Lifestyle 101 – 759 Counts 

Light 760 – 1952 Counts 
Moderate 1953 – 5724 Counts 
Vigorous 5725 – 9498 Counts 

Very Vigorous 9499 and higher Counts 
Table 16 – Default Cut Points 

Bouts 
Bouts are defined as periods of activity bound by a minimum time and a range of activity levels.  ActiLife5 allows users to 
detect the number and length of such bouts in multiple datasets.  The Bout Settings define the bout boundary criteria 
(minimum required length, minimum count level, and maximum count level) as well as the tolerance or drop time. 

A valid bout is any consecutive group of epochs that fall within the minimum and maximum count levels.  These 
consecutive grouping of epochs must be at least as long as the minimum bout length as defined in the Bout Settings.  
The tolerance/drop time sets the maximum number of epochs that may fall outside of the count boundaries in order for 
the bout to still be considered valid. 

Bouts must start and end with valid bout values (values between the minimum and maximum count levels) 

Bout Example 
- Minimum Bout Length: 10 minutes 
- Minimum Count Level to be considered a Bout: 1953 
- Maximum Count Level to be considered a Bout: 5724 
- Tolerance/Drop Time (in minutes): 2 
- Dataset collected in one-minute epoch lengths 
- A string of epoch values from the dataset 
- 1805, 2048, 3159, 4651, 4216, 4673, 5531, 1846, 2615, 2648, 3894, 4869, 5201, 5756, 6165 
- This string contains one bout: 
- 2048, 3159, 4651, 4216, 4673, 5531, 1846, 2615, 2648, 3894, 4869, 5201 
- The value 1846 is considered the first “drop” time 
- The value 5756 is considered the second drop time  
- The value 6165 is considered the third and final drop time.  ActiLife regresses the dataset once 6165 is detected 

to find the last “good” value.  This defines the end of the dataset.  

 

Heart Rate EE 
The Heart Rate EE option calculates the following variables from any datasets that are loaded in the Data Scoring tab. 
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ADL Heart Rate: Average Daily Living Heart Rate.  This is the average base (resting) heart rate of all ADL qualified epochs 
in the dataset.  In order to qualify as ADL heart rate, an epoch must contain heart rate data below 79 beats per minute 
and one-minute activity data above 100 counts per epoch. 

Avg Active Heart Rate: The average active heart rate in a given dataset.  In order to qualify as active heart rate, epoch 
activity must exceed 1951 counts per minute epoch and heart rate must exceed 80 beats per minute. 

HR Delta: The difference between the Average Active Heart Rate and the Average Daily Living Heart Rate for a given 
dataset 

Avg Active Caloric Expenditure: The average minute-by-minute caloric expenditure (kcal) for all epochs that match the 
“Active Heart Rate” qualifier used to calculate Average Active Heart Rate.  Calories are calculated using the Freedson 
Equation (1997).  

Calibration Ratio: Average Active Caloric Expenditure / HR Delta.  This value is used to determine calories-per-BPM, or 
calories that should be associated with the subject’s BPM rate (Active Heart Rate) when activity counts are not reliable. 

The HREE algorithm should not be used as a standard for measuring activity energy expenditure and is only an estimate 
of overall energy expenditure when ambulatory movement is not reliable.  For example, HREE may be used when a user 
is riding a bicycle or lifting weights. 

Children’s METs 
Similar to the ‘Cut Points’ analysis, the ‘Children’s METs data scoring option is used to categorize activity data in children 
between the ages of 6 and 18 years.  Once datasets are loaded, “Gender” and “Age in Years” must be set for each 
dataset prior to calculating METs.  Similar to energy expenditure calculations, cleaned data can be used if desired.  MET 
levels and names can be adjusted using the settings section of the ‘Children’s METs scoring tool. 
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Sleep Scoring 
Sleep scoring can be performed on any dataset to determine sleep efficiency and other parameters that may indicate 
sleep problems.  Any combinations of the various initialization modes are allowed for a given dataset file (activity, dual-
axis, steps and heart rate).  ActiLife will attempt to re-integrate data collected at epoch intervals less than 60 seconds as 
all scoring is performed using 60 second epoch cycles.  

To begin scoring a particular dataset, click the “Select Dataset” option from the top of the Sleep Scoring tool and browse 
to an .agd file that contains data collected during sleep episodes.  Graphs of each day in the dataset will appear in the 
“Sleep Scoring” view. 

 
Figure 46 – Sleep Scoring 

Areas on the graphs can be magnified by dragging the mouse pointer over the area of interest as shown in Figure 47.  To 
return to the normal view, click the small circle in the bottom left-hand corner of the graph. 
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Figure 47 – Graphing 

Entering Sleep Times 
Sleep times (time in or out of bed) can be entered into the Sleep Scoring tool using two different techniques.  To key-in 
sleep times, select the “Add Bed Time” button on the right of the Sleep Scoring tool.  Enter the subject’s exact time in 
bed and time out of bed and click “ok.”  The selected time slot will be highlighted in translucent red on the graph.   

Sleep times can also be added directly on the graph itself by clicking anywhere on the graph and using the arrow keys to 
navigate to the sleep episode start time.  Once a suitable start time is located, right-click anywhere on the graph and 
choose “Add New In Bed Time Here.”  This will mark the start of the sleep episode.  Repeat this process and choose 
“Accept Out Of Bed Time” to mark the end of the sleep episode.  Figure 48 illustrates this process. 

            
Figure 48 – Marking Sleep Episodes Graphically 

Removing Sleep Times 
Sleep periods can be removed by right-clicking on them on the graph and choosing “Delete Current Sleep Period.”  To 
delete all of the sleep periods for a particular day or for the entire dataset, choose the proper corresponding option.  
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Sleep periods can also be removed by selecting the sleep period in the list to the right and clicking the “Remove” button 
below the list. 

Activity and Lux Scale 
The “Activity Scale” and “Lux Scale” settings below the sleep graphs adjust the maximum scale shown for Activity and 
Lux counts on the sleep graphs.  Changing the value scales all of the graphs simultaneously. 

Changing Graph Colors 
Graph colors for activity, lux, the sleep score period, and the score indicator can be changed easily by clicking the color 
palette beside the corresponding item and choosing a different color as shown in Figure 49.  Note that the “Period 
Color” is translucent and may appear slightly lighter than its selected color. 

 
Figure 49 – Color Palette for Sleep Scoring Graph 

Lux 
Lux, or ambient light, is measured by ActiGraph’s ActiSleep monitor , the ActiTrainer and the GT3X-plus devices.  
Ambient light may affect subject sleeping habits and thus is a useful tool in analyzing circadian rhythms and sleeping 
patterns.  If lux data was recorded by the ActiGraph device, it will appear in yellow on the sleep graphs as shown below 
in Figure 50.  The lux data can be hidden by deselecting the “Show LUX data” option at the bottom of the screen.  Details 
regarding the significance of the lux values are revealed by hovering the mouse pointer over the “Lux Info” link at the 
bottom of the screen as shown in Figure 51. Note that these levels are only estimates and are not meant for exact 
interpretation of the light detected by the device. 
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Figure 50 – Lux Data Overlay on Sleep Graphs 

 

 
Figure 51 – Lux Thresholds 

 

Sleep Scoring Algorithms 
The sleep scoring tool uses one of two algorithms (Sadeh 7or Cole-Kripke8

                                                            
7 “Automatic Sleep/Wake Identification From Wrist Activity”, Roger J. Cole, Daniel F. Kripke, etal, Sleep 12(5):461-469, 1992 
American Sleep Disorders Association and Sleep Research Society 

) to determine minute-by-minute 
asleep/awake status.  These algorithms are selectable by the user and can be changed instantly for comparison 
purposes.  The algorithms are described here. 

8 “Activity-Based Sleep-Wake Identification: An Emprical Test of Methodological Issues”, Avi Sadeh, K.M. Sharkey and M. A. 
Carskadoon, Sleep17(3): 201-207, 1994 American Sleep Disorders Association and Sleep Research Society 
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Cole-Kripke Algorithm 
The Cole-Kripke algorithm is considered appropriate for use with adult populations because it was developed using 
subjects ranging from 35 to 65 years of age.  Roger J. Cole and Daniel F. Kripke adapted a scoring method developed by J. 
B. Webster with an experimental wrist actigraph for the AMI actigraph in 1992.  It was developed using 10, 30 and 60 
epochs, with the highest level of accuracy resulting from data collected at10 second epoch periods. 

The algorithm was adapted to the ActiGraph ActiSleep monitor by performing a side by side test using the AMI device 
and the ActiSleep monitor worn together.  The data were scaled then put through the algorithms until the ActiSleep 
monitor sleep score matched that from the AMI device. 

Sadeh Algorithm Summary 
The Sadeh algorithm was developed by Dr. Avi Sadeh from Tel-Aviv University in Israel and is considered appropriate for 
younger populations because it was developed using subjects ranging from 10 to 25 years of age.  He used the same 
device that Cole-Kripke used to develop their algorithm, and ActiGraph therefore adapted it in the same way by scaling 
our data until it matched up with the scoring results of the AMI device.  In general terms, this algorithm determines a 
subject’s sleep state by examining the ActiGraph activity over an 11 minute sliding window.  For any given window, a 
“Sleep Score” (whether the person is asleep or not) can be determined by applying this formula.  After selecting a sleep 
time (Time In Bed (TIB) and Time Out of Bed (TOB)) each minute of sleep data is analyzed this way.   

Sleep Score Information 
Both algorithms will yield the following information within ActiLife’s Sleep Scoring tool for each sleep period.  Sleep 
period scores can be seen by clicking on the sleep period of interest on the right-hand side of the screen (see Figure 46 
for an illustration). 

Sleep Onset - The first minute that the Sadeh scores “asleep.” 

Total Sleep Time (TST) – The total number of minutes scored as “asleep.” 

Wake after Sleep Onset (WASO) – The total number of minutes the subject was awake after sleep onset occurred. 

Awakenings - The number of different awakening episodes as scored by the algorithm.  This is sometimes referred to as 
Frequency of Awakenings (shown as the number of awakenings per night). 

Avg Awakening – The average length, in minutes, of all awakening episodes. 

Total Counts – The total actigraphy counts summed together for the entire sleep period. 

Efficiency –Defined as the proportion of sleep in the episode potentially filled by sleep (i.e., the ratio of total sleep time 
to time in bed) or Sleep Efficiency = Total sleep time multiplied by time in bed. (JSD); Normal sleep efficiency is at least 
85% (asleep 85% of the night). It is reduced in a number of situations, such as insomnia or simply lab effect. 
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ActoGram View 
The ActoGram view option provides the user with the ability to quickly discern circadian patterns in sleep behavior by 
scaling and compressing the sleep graphs.  Enable the ActoGram view by choosing the radio button corresponding to 
this view at the bottom of the Sleep Scoring tool.  Figure 52 illustrates an ActoGram view. 

 
Figure 52 – ActoGram View 

Saving the ActoGram 
The ActoGram can be saved as a sharable image by clicking “Save ActoGram at the bottom of the graph.  This option will 
give the user the option to export the ActoGram to a .jpg image for sharing.   

Show Sleep Epochs 
Clicking the “Show Sleep Epochs” button will load a matrix of each epoch in the dataset with details about whether the 
epoch was scored as a “Sleep Epoch” (indicated by an “S”) or a “Wake Epoch” (indicated by a “W”).  This list can be 
exported to CSV by clicking “Save” at the bottom of the form or by copying and pasting the values. In addition, the entire 
list can be copied to the clipboard by clicking the corresponding button – the list can then be pasted into any text editor. 
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Save Sleep Report 
Sleep scores produced in the Sleep Scoring tab can be exported to either a CSV or PDF file by clicking the “Save Sleep 
Report” option at the bottom right-hand side of the screen.  Select the desired output from the options dialog that 
appears.  Browse to the export location, type a file name, and click “Save” to begin the export. 

 
Figure 53 – Lux Thresholds 
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Graphing 
ActiLife5’s graphing tab allows users to quickly see graphs of each day in a given dataset.  Click “Select Dataset” and 
browse to an .agd file containing data.  The graphs will load vertically and will be ordered from latest to most recent 
date, ascending downward.  Zooming is accomplished by dragging the mouse over the area of interest as shown in 
Figure 47.  Graphs can be reset by clicking the small icon in the bottom left-hand corner of the graph which is also 
illustrated in Figure 47. 

Exporting 
Graphs can be exported to a PDF by clicking “Export to PDF” in the top right corner of the Graphing tab.  Selecting “Keep 
any zoom information” will output the graph with the current zoom view (if any).  Individual days can be exported to pdf 
by checking or unchecking the days in the Export dialog. 

 
Figure 54 – Graphing Export Dialog 

Mode Options 
The “Mode Options” section to the right of the graphs gives users the ability to add or remove data items and change 
the color of various items on the graphs.  If a dataset contains three-axis activity information (i.e., if the device was set 
to collect three-axis data upon initialization), all three axes will be available for selection (not disabled) in the “Mode 
Options” section.  Deselecting any axis will remove it from the graph view.  Multiple axes can be enabled simultaneously; 
however, in order to avoid cluttering the graph view, only one alternative data point can be shown simultaneously with 
activity data.  To enable Steps, Heart Rate, Lux, or Inclination, select the radio button corresponding to the correct data 
point.  A legend explaining the meaning of each data point will appear below the “Mode Option” section when a given 
data point is selected as shown in Figure 55.  Axis values can be scaled by entering new values into the activity scale 
boxes to the right of the graphs. 
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Parameter graph colors can be selected by clicking the palette icon to the right of the variable of interest and choosing 
the desired color.  The graph will immediately update with the new color. 

 
Figure 55 – Graph Legends 

Axes Scaling 
Unless specified, each day shown in the graphing area is scaled individually according to the maximum values collected 
on that day.  By checking the “Equal Scales” option on the right, all activity graphs will be scaled evenly according to the 
number in the scale box.  These scale boxes can be seen in Figure 55. 
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Data Comparison 
The Data Comparison tool allows users to compare ambulatory activity data collected during private studies with other 
public activity datasets that were generated from ActiGraph devices.  ActiLife version 5.5.0 introduces this feature with 
the option to compare data against one public dataset – the 2003-2004 and 2005-2006 National Health And Nutrition 
Examination Survey (NHANES) data collected by the Center for Disease Control and Prevention.  More information about 
this dataset can be found at http://www.cdc.gov/nchs/nhanes/about_nhanes.htm. 

The goal of the data comparison tool is to provide ActiLife users with the ability to objectively compare their own 
actigraphy data with that of national or world-wide standards in an effort to understand correlations among the 
datasets.  As more datasets become available, ActiLife will continue to expand this offering, eventually providing various 
disease research study information and chronic illness baseline data.   

The Data Comparison output graphically compares the users’ data to the NHANES data through a series of column 
charts. 

Loading Datasets for Comparison 

Adding Subjects 
As datasets are added to the Wear Time Validation and Data Scoring tools, they are automatically loaded into the Data 
Comparison tool.  To see these datasets (or to load more), click the “Load/Edit Subjects…” button at the top of the Data 
Comparison grid.  A form similar to the one shown in Figure 56 will appear.  Rows highlighted in red indicate that more 
metadata information is required in order to fully compare this user to the other users in the baselines database(s).  In 
the example shown in Figure 56, the user shown in red will be compared on all parameters except for weight.  For 
instance, three females and three males will appear in the gender comparison graph, but only five users will be 
compared in the weight category. 

http://www.cdc.gov/nchs/nhanes/about_nhanes.htm�
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Figure 56 – Data Comparison Subject Form 

 

If ActiLife detects that there are missing metadata within your subject data (as is the case in Figure 56), a hyperlink will 
appear in the “Your Subject Data” area near the top of the Data Comparison tool as shown in Figure 57.  Click the 
hyperlink to instantly launch the subject grid as shown in Figure 56 to quickly make corrections.  Note that comparisons 
can still be made on the metadata that is present, even if a subject’s metadata is only partially populated. 

 
Figure 57 – Indicator that Subject Files are Missing Metadata 
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Comparing only Validated Data 
To exclude “invalid hours” as determined by the Wear Time Validation tool, check the “use Validated Data if Available” 
option in the Your Subject Data area.  Doing so will exclude invalid whole hours that have been flagged in your datasets.  
For more details, see Wear Time Validation. 

Filtering Data 
Data comparisons are not limited to the entire scope of the datasets for NHANES and/or the user’s subject data.  Use 
the “NHANES Data Filter” section to isolate your comparison to subsets of data.  Change the dropdown on the selected 
parameter to “Custom” and enter in the custom range for the desired comparison.  For Gender, choose either Male or 
Female.  For example, to compare your data strictly to 20 year olds in the NHANES program, change the “Age” filter to 
20 to 29 as shown in Figure 58.  Doing so will also eliminate any NHANES users who do not meet this qualification from 
the other comparison groups.  For instance, any NHANES users who are over 29 will be excluded from the weight 
comparison. 

 
Figure 58 – Custom Filtering for Data Comparison 

Clicking the “Apply Filter to Your AGD Files” will apply the same filters to your own data.  Leaving this option unchecked 
will include the entire breadth of your own subject data when making comparisons.  In the example shown in Figure 58, 
all subject data (even outside of the age group limitation) will be compared across the 20-29 year old subjects within 
NHANES.  Checking the “Apply Filter to Your AGD Files” option would compare only 20-29 year olds in the subject data 
to 20-29 year olds in the NHANES data. 

Running the Comparison 
To run the comparison, click the “Calculate” button after making all filter selections and subject metadata changes.  A 
subject comparison count will appear to the left of the “Calculate” button indicating how many subjects exist in the 
NHANES study as compared to the user’s local study.   
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Comparison Graphs 
The comparison graphs can be enlarged by double-clicking on them.  To return to the normal view, double-click on the 
chart again.  As shown in Figure 59, users can also hover over the chart areas to see details about the comparison 
numbers.   

 
Figure 59 – Data Comparison Graphs 

Charts can be enabled or disabled by checking the graph selection boxes at the top of the Data Comparison tool.  In 
addition, chart color changes can be made by clicking the color palette to the left of the data legend at the top. 

Exporting 
The Export option in the Data Comparison tool produces a PDF graph of all of the visible graphs in the chart area.  
Unselected graphs will not appear in the PDF export. 

More Databases for Comparison 
The data comparison tool was designed by requests from our users.  It is our goal to improve the value of this tool by 
making accessible multiple baseline datasets for comparison instantly within ActiLife.  The convenience of this tool 
combined with the accuracy of ActiGraph’s devices can result in significant time savings for researchers preparing 
abstracts or making comparisons as part of a large longitudinal study.  If you would like to contribute a database for 
comparison within ActiLife, contact us at support@theactigraph.com with subject: ActiLife Data Comparison Database 
Contribution.  

mailto:support@theactigraph.com�
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Preventative Inspection, Maintenance, and Cleaning 
All of ActiGraph’s devices are manufactured in such a way that preventative maintenance is typically not required. This 
required.  This includes device calibration.  However, in order to ensure proper operation and to minimize loss of data all 
devices should be visually inspected prior to each deployment.  This is especially true for water resistant devices, in 
which any o-ring/gasket should be inspected to ensure no cracks are present.9

Devices may be cleaned using an isopropyl alcohol wipe. 

 

Manufacturer’s Warranty, Repairs and Maintenance Agreements 

Manufacturer’s Warranty  
ActiGraph’s warranty and return policy can be viewed at http://www.theactigraph.com/policies.asp.  

If a warranted defect is discovered, please contact customer support by phone or email.  Return instructions will be 
provided. 

Email: support@theactigraph.com 
Phone: (850)-332-7900. 

Customer is responsible for all shipping and handling costs, as well as any applicable Taxes, Tariffs, Duties, etc. ActiGraph 
is not responsible for devices damaged due to poor or defaced packaging or lost shipments.  

Repairs 
In the event that your ActiGraph must be returned for repair, please contact ActiGraph via phone or email (see above).  
Return instructions and a fee schedule will be provided.  Quotes will be provided upon request. 

All repair work has a 90-day Warranty, covering parts and labor. Customer is responsible for all shipping and handling as 
well as any applicable taxes, Tariffs, Duties, etc.  ActiGraph is not responsible for devices damaged due to poor or 
defaced packaging or lost shipments. Delivery times vary; please allow 2-3 weeks for return of the product.  

Maintenance Agreements 
Customized Maintenance Agreements and Extended Warranties are available for the Actigraphs at the time of purchase. 
Please contact an ActiGraph Customer Service Representative to discuss your specific maintenance and warranty 
requirements. 

                                                            
9 The end user should not, under any circumstance, disassemble a device for maintenance or inspection.  Doing so will void any 
warranty currently in place. 

http://www.theactigraph.com/policies.asp�
mailto:acti_service@theactigraph.com�
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Customer is responsible for all shipping and handling costs. ActiGraph is not responsible for devices damaged due to 
poor packaging, defaced packaging, or lost shipments. Delivery times vary; please allow 2-3 weeks for return of the 
Actigraph. 

ANY ADDITIONAL QUESTIONS OR PROBLEMS, PLEASE CALL 850.332.7900 OR EMAIL:  
SUPPORT@THEACTIGRAPH.COM 

Appendix A – File Types in ActiLife5 

*.gt3x File Format 
GT3X+ devices produce an interim compressed file with file extension *.gt3x.  This is a compressed file and must be 
extracted to a usable format using ActiLife’s import/export tool which is accessible from the File menu in ActiLife.  The 
file can be exported to *.agd format for processing in ActiLife or *.csv/*.dat format for processing using third party tools.  
The *.gt3x file can also be exported directly to *.agd format during the download process by checking “Create AGD File” 
from the download prompt (see Downloading GT3X+ Devices for more information). 

*.agd File Format 
The *.agd file format is ActiLife’s native file format and is the desired file type for all ActiLife operations and tools such as 
Wear Time Validation, Data Scoring, Sleep Scoring, and Graphing.  *.agd files are database files formatted for use with 
the popular SQLite architecture (www.sqlite.org).  These files can be viewed in the ActiLife AGD viewer (available from 
the File menu).  Alternatively, the SQLite browser (publically available on the SQLite website) can be used to browse the 
details of the *.agd files.  A file schema is provided in Figure A1. 

 
Figure A1 - *.agd File Schema 

mailto:SUPPORT@THEACTIGRAPH.COM�
http://www.sqlite.org/�
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*.agd files are created in ActiLife immediately when data from a GT1M, GT3X, ActiTrainer, or ASM device is downloaded 
through the “Devices” tab.  These *.agd files typically contain post-filtered and accumulated data as this is the only type 
of data that ActiLife can properly handle.  The rows in the database represent whole-number epoch summations (1s, 5s, 
10s, 30s, 60s, etc.).  However, at the time of this writing all GT1M, GT3X, ActiTrainer, and ASM products that have been 
initialized to collect raw data (12Hz or 30Hz) will produce an *.agd file on download.  Although the file cannot be 
processed in ActiLife, the *.agd format can be exported to *.csv or *.dat through ActiLife’s import/export tool or AGD 
viewer tool, both accessible from the File menu. 

GT3X+ devices produce a *.gt3x file on download (see *.gt3x File Format).  In order to process in ActiLife, the file must 
be exported to *.agd format.  This can be done at the time of download by checking “Create AGD File” from the 
download dialog box or by using ActiLife’s built-in import/export tool available from the File menu. 

*.agd Data Table Format 
The data table in the *agd database consist of the following parameters.  Their calculations are explained. 

dataTimeStamp – a measure of total Ticks.  A single tick represents one hundred nanoseconds or one ten-millionth of a 
second. There are 10,000 ticks in a millisecond.  The value of this property represents the number of 100-nanosecond 
intervals that have elapsed since 12:00:00 midnight, January 1, 0001.  More information available at 
http://msdn.microsoft.com/en-us/library/system.datetime.ticks.aspx  

axis 1 – Post filtered and accumulated per-epoch vertical activity data 

axis 2 (optional) – Post filtered and accumulated per-epoch horizontal activity data 

axis 3 (optional) – Post filtered and accumulated per-epoch perpendicular activity data  

steps (optional) – Total steps per epoch 

hr (optional) – Heart beats-per-epoch.  This data is only gathered by ActiTrainer devices when those devices are 
initialized to collect heart rate data AND when the Polar® Heart Monitor (wireless heart strap) is worn by the user. 

Lux (optional) – Ambient light sampled once per second (on GT3X+ and ASM devices only) and averaged over the length 
of the selected epoch.  (e.g., for 60s epochs, this would be the light values summed once per second and divided by 60). 

Inclinometer (optional) – Device orientation information.  This is calculated by sampling the angle of the device over the 
entire length of the epoch (30 times per second) and selecting the predominant angle; i.e, the angle “range” that 
appeared the majority of the time over the epoch.  For details about inclinometer functionality, see the Inclinometer 
Whitepaper. 

*.dat File Format 
Older versions of ActiLife produced *.dat files when downloading data from devices.  These files consist of ten (10) lines 
of header data (meta information about the content) followed by epoch accumulated/filtered data.  This “DAT” file 

http://msdn.microsoft.com/en-us/library/system.datetime.ticks.aspx�
https://docs.google.com/document/d/1EBAEcAL34k0ONZOgfXZPsMJJC-Uy9d49FFyPnmPH3Qc/edit?hl=en&authkey=CM--zvgE�
https://docs.google.com/document/d/1EBAEcAL34k0ONZOgfXZPsMJJC-Uy9d49FFyPnmPH3Qc/edit?hl=en&authkey=CM--zvgE�
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stores all of the activity (1 to 3 axis), pedometer, Inclinometer, and/or heart rate data in ASCII format.  This file also 
contains the Serial Number, Start Time, Start Date, Epoch Period, Download Time, Download Date, Current Memory 
Address Pointer, Current Battery Voltage, Mode and First Start Time (used to build the DAT file) as part of its ten (10) 
line header information.  The file can be viewed with any standard text editor such as MS Notepad. The Mode value 
given in the header of the DAT file outlines which features were active during data collection for the file.  Table 17 
outlines the values of the Mode variable. 
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Table 17 – DAT File Modes 
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The “DAT” file data is interleaved in the following priority order based on the Mode value. 

Device .DAT file data priority 
(order of appearance) 

GT1M/GT3X/ASM 1) Activity 
2) Steps 

ActiTrainer 

1) Activity 
2) Steps 
3) Heart Rate 
4) Workout Activity (0 unless device is in workout mode) 
5) Workout Steps (0 unless device is in workout mode) 

Table 18 – Order of data appearance in DAT file 

Note that the ActiTrainer records workout data in a separate memory slot.  This separation is done primarily for 
commercial customers, runners for example, that are interested in obtaining the exact number of steps taken or 
distance travelled as soon as a workout is enabled, which could occur in the middle of an epoch.   

Note: Workouts can only be enabled while the ActiTrainer display is enabled and only during 60 
second epochs 

 
.dat file examples 
The following examples serve to illustrate the organization of the DAT files 
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ActiTrainer 

.dat file with activity only 
------------ Data File Created By ActiTrainer ActiLife v3.3.1 Firmware v5.2.0 ----------- 
Serial Number: PUL1B30060050 
Start Time 23:50:00 
Start Date 12/31/2007 
Epoch Period (hh:mm:ss) 00:01:00 
Download Time 11:49:07 
Download Date 4/14/2008 
Current Memory Address: 618 
Current Battery Voltage: 3.88     Mode = 0 
First Start Time: 37 
-------------------------------------------------- 
    1730       0          0     561       0         0     164… 
 
      A1      WA1    WS1   A2    WA2   WS2   A3 … 
A1, WA1 and WS1 represent Activity, Workout Activity and Workout Steps for the first epoch (23:50:00 to 23:51:00).  
Note: workout activity and workout steps are ALWAYS recorded and included in the dat file. 
 

.dat file with activity and step count 
------------ Data File Created By ActiTrainer ActiLife v3.3.1 Firmware v5.2.0 ----------- 
Serial Number: PUL1B30060050 
Start Time 23:50:00 
Start Date 12/31/2007 
Epoch Period (hh:mm:ss) 00:01:00 
Download Time 12:19:50 
Download Date 4/14/2008 
Current Memory Address: 1176 
Current Battery Voltage: 3.95     Mode = 1 
First Start Time: 50 
-------------------------------------------------- 
     655       1          0         0      243    3        0       0        330 
 
      A1       S1     WA1   WS1   A2    S2    WA2   WS2    A3… 

 
- A1 represents the Activity Data from 23:50:00 to 23:51:00. 

- S1 represents Step Count (Pedo) from 23:50:00 to 23:51:00. 
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- WA1 represents the Workout Activity Data from 23:50:00 to 23:51:00. 

- WS1 represents Workout Step Count (Pedo) from 23:50:00 to 23:51:00. 

- A2 represents Activity Data from 23:51:00 to 23:52:00. 

- S2 represents Step Count (Pedo) from 23:51:00 to 23:52:00. 

- WA2 represents Workout Activity Data from 23:51:00 to 23:52:00. 

- WS2 represents Workout Step Count (Pedo) from 23:51:00 to 23:52:00. 

- A3 represents Activity Data from 23:52:00 to 23:53:00. 

This cycle repeats for the entire length of the file.  If a workout had been activated on the device, the WA and WS 
bytes would have values. 

.dat file with activity, step count and heart rate data 
------------ Data File Created By ActiTrainer ActiLife v3.3.1 Firmware v5.2.0 ----------- 
Serial Number: PUL1B30060050 
Start Time 23:50:00 
Start Date 12/31/2007 
Epoch Period (hh:mm:ss) 00:00:30 
Download Time 13:24:27 
Download Date 4/14/2008 
Current Memory Address: 1390 
Current Battery Voltage: 3.99     Mode = 3 
First Start Time: 60 
-------------------------------------------------- 
     692       2     120        0          0     2524   9     156       0          0 
 
     A1     S1     HR1    WA1   WS1    A2    S2   HR2    WA2    WS2 

Similar to the previous example, A1, S1, HR1, WA1 and WS1 represent Activity, Steps, Heart Rate, Workout Activity and 
Workout Steps from the first epoch.  However, 0:30s epochs were used.  Therefore, the first epoch time period is from 
23:50:00 to 23:50:30.  The second set (A2, S2, HR2, WA2, WS2) represents data collected between 23:50:30 and 
23:51:00.  Again, this pattern continues for the entire length of the file.  
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.dat file with dual axis activity, step count and heart rate data 
------------ Data File Created By ActiTrainer ActiLife v3.3.1 Firmware v5.2.0 ----------- 
Serial Number: PUL1B30060050 
Start Time 23:50:00 
Start Date 12/31/2007 
Epoch Period (hh:mm:ss) 00:00:30 
Download Time 13:24:27 
Download Date 4/14/2008 
Current Memory Address: 1390 
Current Battery Voltage: 3.99     Mode = 13 
First Start Time: 60 
-------------------------------------------------- 
     692     534     2     120       0         0     2524   962      9     156       0          0 
 
     A1       X1      S1    HR1   WA1   WS1    A2      x2       S2   HR2    WA2    WS2 

Similar to the previous example, A1, X1, S1, HR1, WA1 and WS1 represent Activity, X=axis Activity Count, Steps, Heart 
Rate, Workout Activity and Workout Steps from the first epoch.  However, 0:30s epochs were used.  Therefore, the first 
epoch time period is from 23:50:00 to 23:50:30.  The second set (A2, X2, S2, HR2, WA2, WS2) represents data collected 
between 23:50:30 and 23:51:00.  Again, this pattern continues for the entire length of the file.  

GT1M 

.dat file with activity only 
------------ Data File Created By ActiGraph GT1M ActiLife v3.2.12 Firmware v3.0.0 ----------- 
Serial Number: LYN2B31062733 
Start Time 23:58:00 
Start Date 12/31/2007 
Epoch Period (hh:mm:ss) 00:00:15 
Download Time 13:23:30 
Download Date 2/18/2008 
Current Memory Address: 262 
Current Battery Voltage: 4.16     Mode = 0 
-------------------------------------------------- 
  0      46     116     179     123 
 
 A1    A2      A3       A4       A5 
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Each epoch is 15 seconds long and contains 1 activity reading.  Note that the GT1M has no workout information.  A1, A2, 
A3, A4 and A5 all represent a separate epoch, each 15 seconds apart. 

.dat file with activity and step data 
------------ Data File Created By ActiGraph GT1M ActiLife v3.2.12 Firmware v3.0.0 ----------- 
Serial Number: LYN2B31062733 
Start Time 23:58:00 
Start Date 12/31/2007 
Epoch Period (hh:mm:ss) 00:00:15 
Download Time 13:41:27 
Download Date 2/18/2008 
Current Memory Address: 1228 
Current Battery Voltage: 4.18     Mode = 1 
-------------------------------------------------- 
  85      3     107       8     239      12 
 
  A1     S1    A2       S2     A3       S3          Each epoch is 15 second long and contains data for activity and steps. 
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